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Chapter 1 • Introduction 

PowerNet Products Overview 
PowerNet products bridge the gap between portable wireless devices and network 
applications, making the entire wireless enterprise as productive, efficient, and reliable as 
possible. The PowerNet family of products supports the following: 
• All Internet-compatible wireless networks, encompassing virtually all wireless LAN 

technologies on the market today. Spectrum One, a proprietary spread spectrum 
wireless technology in the 900Mhz band, is also supported. 

• All Internet-compatible wire network media, including Ethernet. 
• All major user interfaces, including HTML, VT, 3270, and 5250. 
• All possible network application architectures including direct client, client-server, 

and three-tier client server. 

PowerNet consists of two major product families that work in unison to deliver a single, 
complete solution for the entire wireless enterprise. The focus of these products is 
described below. 
• PowerNet OpenAir: Hardware and middleware solutions for the wireless automatic 

identification industry. This family includes the Linux-based OpenAir Linux, the 
Windows-based OpenAir Windows, the version of OpenAir Windows that loads 
directly on a customer’s AS400 host, OpenAir 400, and the universal terminal client 
software, PowerNet Twin Client. 

• PowerNet DataLinc: Application development tools for the wireless client-server 
environment. This currently includes PowerNet AirLinc for use with ODBC 
compliant databases. 

PowerNet Twin Client Overview 
PowerNet Twin Client is a software package that provides VT100, VT220, TN3270 
(Telnet 3270), and TN5250 (Telnet 5250) emulation on portable terminals. It includes an 
easy-to-use Windows program for configuring and downloading the software to the 
portable terminals. 
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Introduction 

Modes of Operation 
PowerNet Twin Client operates in either of two modes: thick client or thin client.  
• Thick client mode (also referred to as Telnet client mode) provides a Telnet 

connection directly to host computers and their applications.  
• Thin client mode (also referred to as Server client mode) communicates directly with 

a PowerNet OpenAir or PowerNet AirLinc server, which in turn provides the 
connection to host computers and their applications. 

The primary difference between the two modes is in processing load distribution: In thick 
mode, all application protocol processing is performed on the terminal, while in thin 
mode, all of the processing takes place on an intermediate OpenAir or AirLinc server. 
Another important difference is optimization: In thin mode, the OpenAir or AirLinc 
server introduces display optimization, data compression, and several other techniques 
that can dramatically reduce wireless network traffic. These optimizations are not 
possible in thick mode. 

All of the user interface features, functions, and capabilities remain the same, regardless 
of the mode of operation. 
 

Major Features 
 
PowerNet Twin Client for Unitech terminals offers the following benefits:  
 

• Simplicity: Twin Client is preset to match the default keyboard overlays and 
functionality of the Unitech Telnet client. No special configuration procedures are 
required. 

• Management: Administrators and integrators can monitor and modify the software 
revision and configuration of each portable terminal from any Windows PC attached 
to the TCP/IP network. Changes are downloaded to the terminals over the wireless 
LAN automatically. 

• Formatting: The Twin Client Terminal Screen Formatter feature is built-in, allowing 
integrators to tailor host application displays to suit the needs of the terminal 
operators without modifying the applications. 

• Internationalization: Error message language translations and character sets are 
menu selections. No additional integration is necessary. 

• Migration: Conversion to a PowerNet OpenAir or PowerNet AirLinc client-server 
environment is automatic because the "thin" client is included in the Twin Client 
software already downloaded to the terminal. 
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  In This Manual 

In This Manual 
This manual is organized as follows: 
• Chapter one provides an overview of the PowerNet product line and an introduction 

to the PowerNet Twin Client. 
• Chapter two describes how to load the PowerNet Twin Client Manager software on 

your PC. 
• Chapter three describes how to quickly configure the PowerNet Twin Client Manager 

and the terminal for automatic, over-the-air software download and subsequent 
Telnet session startup. 

• Chapter four describes how to change the Standard setup options specific to VT, 
3270, and 5250 emulations. The simple, time-saving features for converting existing 
Unitech Telnet client installations to PowerNet are also described here.  

• Chapter five describes how to use the Advanced setup options for VT, 3270, and 
5250 emulations. These options are used to customize keyboard, display, scanner, 
timer, alarm, and printer operation. 

• Chapter six describes how to use the Twin Client advanced integration tools to 
further customize terminal operation. The creation and use of mapping, macro, 
dialog, and scanner control objects are described. 

• Chapter seven describes the use of the built-in Twin Client Formatter, and how to 
configure the portable terminal to use screen formatting. 

• Chapter eight describes how to use the Auto-Configuration tool to manage and 
automatically maintain the software configuration of all terminals on the wireless 
network. Also described are software management procedures and options that are 
unique to Unitech terminals. 

• Chapter nine is a reference for the ISO 8859-1 and ASCII character sets. 
• Chapter ten is a reference for the default keyboard configurations for Unitech 

terminals using PowerNet Twin Client in advanced mode.  Figures and tables are 
included for 3270, 5250, and VT. Also included for reference are the Unitech 
terminal control sequences. 

• Chapter eleven is a reference for error message resolution in Twin Client.  
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Chapter 2 • Installation 
This chapter describes the installation of the PowerNet Twin Client software on a PC.  
The software is available on CD-ROM or it can be downloaded from the Connect web 
site. Instructions are provided for both methods. 

Requirements 
Installation of PowerNet Twin Client requires, at a minimum, the following: 
• A Pentium-class processor  
• 32 MB of RAM 
• 10 MB of free hard disk space available 
• The PT900, PT930, and PT930SA terminals require Microsoft Windows CE. The 

PA960 terminal requires Microsoft Windows CE 3.0 / Windows CE.NET 4.2. 
• ActiveSync needs to be installed on the PC before downloading files to the terminal.  

ActiveSync is freely downloadable from the Microsoft web site, at 
www.microsoft.com/downloads. For instructions, go to www.msdn.microsoft.com. 

Downloading from the Web 
The PowerNet Twin Client software package can be downloaded from the Connect web 
site at http://www.connectrf.com. Click on Partner Services and then click on Software 
Downloads. Select the file named PowerNet Twin Client for Unitech. 

Running Setup from a Download File 
The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk as shown in the following 
figure. 

 

Click on the Disk1 folder to view the files as shown in the following figure. 
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Installation 

 

Click on the Setup application and proceed to the following section entitled Installation 
for further instructions. 

Installation 
The InstallShield wizard runs and presents the following screen. 

 
Click on Next to begin the installation process.  
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  Installation 

 
To change the default Destination Location, click on Browse and select a location. Then 
click on Next.  

 
The d fault folder is PowerNet. This default may

g program group or by typing in a new name at the prompt. Then click on 
e  be changed either by selecting an 

existin Next. 
The Po
folder

werNet Twin Client Manager and terminal files are then installed in the target 
.  
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Installation 

 
When the installation is complete, reboot the system to initialize the Twin Client 
software. 

a. n Finish.  

b To e computer later, and then click on 
Finish.  

Running e
The ow  that manages the terminal software and 
configurations. 

Select Start, P

To reboot the system immediately, click o

. reboot later, click on the option to restart th

th  Manager 
 P erNet Twin Client Manager is the utility

rograms, PowerNet, and Twin Client Manager.  

Note: I d ends when the Twin Client 
Manager is run, move the file at this link 
f the PowerNet splash screen flashes for a second an

(http://www.connectrf.com/Documents/fix-flash.reg) to the system with the 
problem and then run it. This issue, found in earlier versions of the Twin Clien
Manager, has been fixe

t 
d in later versions by using a later MS compiler and 

libraries. 

The PowerNet Twin Client Manager screen appears as shown in the following figure. 
This is the administrator's main screen, and all functions are accessed from its menu bar, 
toolbar, and tabs. 
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  Running the Manager 

Menu Bar 
The menu bar provides access to the functions used to configure the terminals and 
manage their software. Subsequent chapters of this manual explain each menu and its 
options.  

 

Toolbar 
Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar 
can be turned on or off by changing the Toolbar parameter found on the View menu. The 
shortcuts available from the toolbar are as follows. 

 Create a new terminal configuration. 

 Open an existing terminal configuration. 

 Save the current terminal configuration. 

 Download the configuration to the terminal. 

 Download software to the terminal. 

 Configure terminals automatically over the wireless network. 

 View the PowerNet Twin Client Manager version. 
 

The PowerNet Twin Client Manager is now successfully installed and ready for use.  
The next chapter provides detailed instructions for quickly configuring the terminal  
and starting a Telnet session. 
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Chapter 3 • Quick Start 
This chapter describes how to prepare the Twin Client Manager and the Unitech terminal 
for a Telnet session with the host. Following an initial serial download, the terminal 
software and configuration are managed automatically over the wireless network. 

Note: Unitech terminals are normally delivered with Unitech files pre-installed. 
However, if the terminal does not have those files installed, refer to Chapter 8, 
Sending Program and Configuration Files to the Terminal, before proceeding. 

Configuring the Manager 
The first step is to configure the Twin Client Manager to meet site-specific requirements, 
and then prepare it for the automatic management of the terminal software and IP 
addresses. This simple procedure will require only a few minutes to complete. 

Setting the Emulation 
Click on Start, Programs, PowerNet, and Twin Client Manager, and then select the 
Settings menu, as shown below. 
 

 

Click on Emulation, select the desired emulation, and then click on OK. 
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Quick Start 

 

Setting the Servers 
The Servers are the Telnet host systems the terminals will access. 
 

 

To set these addresses from the Settings menu, click on Servers and then click on Add. 
Enter the name of each server, its IP address and IP port (normally 23 for Telnet servers), 
and emulation type. Then click on OK.  

 

Repeat this step for each Telnet server the terminals are required to access. If an error is 
ade in the name, IP address, IP port number, or terminal emulation type, click on the m

line that is in error and then click on the Edit button to make the corrections. Use the 
Load button if you want to load an .svr file. Use the Sav
y
 
On CE terminals it is possible to use DNS (Domain Nam
th
set the IP address to 0.0.0.0. 
 
Note: Some DOS terminals also support DNS host 

e As button if you want to save 
our file as an .svr file. 

e System) lookup to determine 
e host address. To set this up, key in the full DNS name in the "Server Name" field and 

lookup. You can determine if your 
device supports this by looking for the presence of a DNS setup option under 
"Terminal Setup" (Shift C). 
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  Configuring the Manager 

 
 
When the client sees the address of 0.0.0.0, it will issue a DNS lookup on the value in the 
"Server Name" field to determine the true IP address. 
 
Please make sure that you have DNS set up on the terminal. On CE terminals, use the 
control panel. On DOS terminals, use the Shift C menu. 
 
You can also "Test" the DNS name lookup in Twin Client Manager (if the Windows PC 
is using the same DNS server as the RF terminal). Just click on the "Lookup" button and 
the true IP will be returned in the IP address field. 
 

 

 
Please make sure to set the address back to 0.0.0.0 before sending this to the terminal. 
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Setting Terminal Operations 
In the Twin Client menu under Settings, choose Terminal Operation. 

 

Run AirLoader on terminal can be selected, and the AirLoader server IP address can be 
entered. The Windows CE options of Run application at startup, Hide task bar, and Use 
GUI menus and screens can be selected.  

 

Click on OK when finished. 

Setting Terminal Model and COM Port 
ecific 

O

The default serial connection to the Unitech cradle is through COM1. To select a sp
Unitech terminal model and keypad, or to change the COM port assignment, click on the 

ptions menu as shown. 
 

 

To maintain compatibility with existing Unitech Telnet client keyboard layouts, a 
specific terminal model and keypad must be selected from the Terminal Model window. 
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  Configuring the Manager 

 
 

Saving the Configuration 
Click on File, and Save As, and then enter a name for this configuration.  
 

 

For the purposes of this example, the name is vt100. 
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Quick Start 

Setting Airloader Auto-Configuration 
ent for each terminal will take place 

 

The configuration download and IP address assignm
automatically by setting the Airloader Auto-Configuration options. 

 

Click on the Airloader option in the Tools menu. 

Note: If the Airloader Auto-Configuration window does not display the options, click on 
the Advanced<< button. 

If multiple network adapters are installed on the PC, ensure that the desired network 
adapter is selected. The adapter selection can be changed by clicking on the Change 
button. 

 

This powerful software management tool is described in detail in Airloader Auto-

To assign terminal IP addresses automatically over the wireless network, check all of the 
boxes as shown above. Then click on the Addresses button and enter the desired range 
in the F

Configuration. For now, it is sufficient simply to use it for assignment of the initial 
terminal configuration and IP address, both of which can be easily changed later. Ensure 
that all of the check boxes are checked as shown above. 

rom and To boxes as shown in the following figure. 
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  Configuring the Manager 

 

After setting the address range, click on OK to return to the Airloader Auto-Configuration 
creen and then click on the box next to Terminal/Group Manager. 

 
s

 
 

The display expands to show the default terminal group. Next, click on the New Group 
icon and use the Browse button to select the configuration file saved earlier. 
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Quick Start 

 

Check the Active box, and the system is now configured to automatically download IP 
addresses, software, and configuration files to the terminals. Click on the  box in the 
upper right corner to return to the main menu. 

Note: The  not need to b . It can be authorized later, after a 
Te ssion has been estab ure is described in the Chapter 4 
se uthorizing PowerNe

 

 

 

 

 

 

 

 software does e authorized now
edlnet se lished. The proc

ction, A t. 
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  Configuring the Terminal for Download 

Configur
On the PC, click on Start, P

ing the Terminal for Download 
rograms, PowerNet, and Twin Client Manager. Under the 

Terminal menu, choose Send Program Files to Terminal, as shown below. 

 

The following screen is displayed. 

 

Choose Yes at the prompt. The following screen is displayed. 

 
 
Click on OK. 
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Downloading the Files 
he cradle, which should display the following Turn on the power to the terminals in t

screen. 
 

Comm Parameters 
 
Start?    <ENT> 

P e te
b  following
progress. 
 

Program loader 

ress Enter on th
he

rminal and return to the Twin Client Manager to click on the OK 
utton. T  should be displayed on the terminal while the download is in 

 
Receiving:  

The download requires approximately 2 minutes to complete. 

Following a successful download a status code of 0000 is displayed on the terminal. Use 

 

the following table of status codes to troubleshoot a download failure. 

Status Code Error 
0002 Receive overrun 
0004 Receive parity 
0008 Receive framing 
0010 Programming voltage absent 
0020 DSR or CD detected on open 
0080 ABORT key pressed 
0100 CD lost during session 
0600 NVM EEPROM failed to erase 
0800 Receive time-out error 
1000 Control start character time-out 
2000 CTS inactive time-out 
4000 Receive buffer full 

In the event of a failure, verify the following: 
 The null modem cable connection between terminal and PC and condition of all 

connectors. 
 The specification of correct COM port. 
 The correct cradle power supply. 
 The blinking of the charging light on the cradle, indicating proper seating of terminal 

in cradle. 

•

•
•
•

  PowerNet Twin Client Reference    •   May, 2006 3-10



  Warm Booting the Terminal 

Warm Bo  Te
Following a successful file download, and at any ti

ina

 In

oting the rminal 
me it is necessary to update the 
l must be warm booted.  terminal software and/or configuration, the term

 
Model structions 
PT900-PT930 
PT930SA 

Fo lick
and Windows. Select the boo

llowing Power OFF - C  on Start, Programs, File Explorer, 
t mode icon. Choose OK. 

PA960 While the PA960 is operating
we on th
the

, insert a pin (a paper clip works 
e back of the terminal, right below ll) into the reset hole 

 PCMCIA cover. 

The completion of the w icated by the following terminal display. 

LATOR US

arm boot is ind
 

LOAD EMU ING 
1 - AirLoad 
2 - Serial Download 

Note: To minimize download time, remove the term

Enter 1 to continue. Option 2 is used for custom download options and is described in the 
ntitle  and Co s to the Terminal.  

, progress messages are displayed on the terminal. Pauses in activity 
inal writes to EEPROM. The download 

plete. 

he following table describes the error messages that will be displayed on the terminal in 
d failure, and can be used as a guide to correcting the problem. 

inal from the cradle. 

Chapter 8 section e d Sending Program nfiguration File

The terminal then associates with an access point, contacts the Twin Client Manager, and 
then downloads the program, configuration, and IP address of the terminal. 

During the download
of up to 10 seconds will be observed as the term
requires approximately 2 minutes to com

T
the event of a downloa
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Error Indication Possible Cause Corrective Action 
NOT Associated Invalid NETID Run CFG24 (or current Unitech radio 

setup program) and set NETID to 
match the access point. See Terminal 
Setup Using Twin Client Menus. 

No AirLoad Manager AirLoad Manager not Ensure that the PC wit
F ve, or not installed 

on the LAN segment 

h Twin Client 
Manager is on the same segment and 
that the PC is operating. If the PC is 
not on the same segment, enter the 
address of the PC in response to the 
terminal prompt. 

ound acti

M Previously identified Same as above. anager not Active 
AirLoad Manager is no 
longer found. 

Unable to open 
connection 

IP stack on terminal 
failed to load. 

Reload Unitech driver files. 

T for 
d

Tran
m

Reboot terminal. If problem persists, imeout waiting 
ata com

sient 
unications failure check the RFSYNC.log in the 

PowerNetTN directory. 
Download aborted Sock

wn
sure PC is operating. Reboot et closed during En

do load terminal and retry. 

Manager inactive PC not operating Restart the PC. 

After taking the corrective action, the terminal must be booted again. A successful 
wireless connection and download is indicated by the display of the Twin Client main 
menu shown below. 
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue 

Note: The date of 2006 on the terminal is updated at the time of a new release. 

The terminal is now ready to establish a Telnet session with the host system. 
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  Starting a Telnet Session 

Starting a Telnet Session 
At the Twin Client main menu on the terminal, press any key to establish the connection. 
Until the terminal has been authorized, the following screen is displayed. 
 

RECOVERABLE ERROR 
Terminal not 
Authorized for 
Twin Client 
 
Keypress to Continue 

It is not necessary to authorize the terminal at this time, so press any key to continue. The 
terminal will establish a connection with the host system and start emulation. If the 
terminal fails to connect to the host, refer to the following table. 
 

Failure Cause Corrective Action 
Incorrect Host IP address Correct the Host List address on the terminal. Refer to the 

Chapter 4 sub-section Terminal Setup Using Twin Client 
Menus for instructions. 

Incorrect netmask value Access Radio Setup menu and correct the netmask value. 
Refer to Terminal Setup Using Twin Client Menus for 
instructions. 

After a Telnet session has been successfully established, the terminal will remain in 
session for a maximum of 30 minutes at a time until it has been authorized. Once 
authorized, there is no software restriction to the session time. The instructions for 
authorizing the terminal are presented in Authorizing PowerNet in Chapter 4. 
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Chapter 4 • Standard Setup 
The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements, it may be necessary to customize terminal operation. The standard 
setup options simplify this process and can be modified by the following methods: 
• Using the Twin Client Manager. 
• Using the Twin Client terminal menu system. 

This chapter describes how to use the Twin Client Manager and the terminal menu 
systems to set up the terminal. Also described are the methods for authorizing the 
terminal software. 

Setup Using Twin Client Manager 
The Twin Client Manager provides a Standard Settings tab for automatic setup of the 
terminals. Select Standard from under the View menu. The options within this tab may 
vary according to the emulation selected, each of which is described below. 

VT Settings 
Select the VT emulation setup by clicking on the Settings menu and then the Emulation 
menu, as shown below.  
 

 

Then click on the VT100 or VT220 selection, as shown below.  
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Standard Setup 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for VT emulation. 

 

Quadrant Mode  
 

s scrolling list option defines the rules by which the terminal display is pThi ositioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 

ws" in the host display, and the terminal display is located on whatever quadrant 

host 
inal display.  

s quadrant processing. However, input fields that cross quadrant 
s result in a shift to the left in order to locate as much of the current input 

"windo
contains the current cursor position. 

 Off disables quadrant processing and Twin Client simply centers the current 
input field in the term

 On enable
boundarie
field on the terminal display.  
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  Setup Using Twin Client Manager 

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

 
hoice of font size for the display of characters. The 

Bold Font check box enables (checked) and disables (unchecked) the display of 
characters in bold font. 

 
This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Printer Type 
 
This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 
 

5250 Settings 
Select the 5250 emulation setup by clicking on the S

 Hard is the same as Soft except the viewing keys are disabled.  

 

Font 

The Font Size scroll box provides a c

Key Click 

ettings menu and then the 
Emulation menu, as shown below.  
 

 

Then click on the 5250 selection, as shown below.  
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Standard Setup 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 5250 emulation. 

 

Quadrant Mode  
 
This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 

lay is located on whatever quadrant 

 Off disables quadrant processing and Twin Client simply centers the current host 

boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

 Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   
 

Font 
 

The Font Size scroll box provides a choice of font size for the display of characters. The 
Bold Font check box enables (checked) and disables (unchecked) the display of 
characters in bold font. 

"windows" in the host display, and the terminal disp
contains the current cursor position.  

input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
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Key Click 
 
This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Printer Type 
 
This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 
 

3270 Settings 
Select the 3270 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below.  
 

 

Then click on the 3270 selection, as shown below.  
 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
m u. The standard settings tab will now reflect the settings for 3270 emulation. en
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Quadrant Mode  
 
This scrolling list option defines the rules by which the terminal display is positioned in 

lay. As defined by Twin Client, quadrants are fixed position 
 display, and the terminal display is located on whatever quadrant 

ursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 

ant processing. However, input fields that cross quadrant 
 in a shift to the left in order to locate as much of the current input 

al display.  

ions on a quadrant boundary regardless of input field boundaries. 
g keys are enabled. 

n 
 host display. The coordinates are zero-based.   

 

characters in bold font.  

the larger host disp
"windows" in the host
contains the current c

 
input field in the terminal display.  

 On enables quadr
sultboundaries re

field on the termin

 Soft always posit
Viewin

 Hard is the same as Soft except the viewing keys are disabled.  

 Lock locks the terminal display origin (upper left corner) to fixed row and colum
(x,y) coordinates in the

Font 

The Font Size scroll box provides a choice of font size for the display of characters. The 
Bold Font check box enables (checked) and disables (unchecked) the display of 
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K  
 
This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

This scrolling list selects the attached printer type. The default value is none, indicating 
ed.  

Termina

ess this menu system, press uppercase C at the startup screen as shown 
in the following figure. 
 

ey Click

Printer Type 
 

that no printer is attach

l Setup Using Twin Client Menus 
The Twin Client terminal software provides an internal menu system for configuring 
certain parameters on the terminal and for switching between thin and thick modes of 
operation. To acc

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue  

 
T ears in thick (Telnet) mode: 

enu appears in thin (Server) mode: 

 

 

he following menu app
  
Edit Server/Host IPs 
Edit License Key 
Switch Client Modes 
Run Client Emulator 
Exit to OS 
  
The following m
  
Edit Server/Host IPs 
Run Site Survey 
Switch Client Modes 
Run Client Emulator 
Exit to OS 

Use the Up-Arrow and Down-Arrow keys to navigate the menu, and press Enter to select 
the highlighted option. Each menu option is described below. 

Edit Server Host IPs 

If the host IP address or addresses were not pre-configured as described in the Setting the 
Servers section of Configuring the Manager, or if you wish to change those settings using
the terminal menus, select this option and enter up to four Host IP addresses as required. 
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     Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit 

Press F3 to save the configurations. 

Edit License Key 

The described in the next section, 

n
obt  the next section. 

 

00A0F826E614 

 client software can be authorized automatically, as 
Authorizing PowerNet. This menu option permits authorization of each terminal 
ma ually. Select this option to obtain the terminal's Identification Code, which is used to 

ain the Authorization code from the Connect web site, as described in

The 12-digit value displayed at the top of the terminal screen is the Identification Code 
for the terminal. 

Authorization 
    ______________ 
 
not authorized 
 
<F3> Save <F7> Quit 

Type the Authorization code into the field as it appears on the web site. Punctuation 
characters, such as the hyphen (-), are required. Press F3 to save the Authorization code. 

Run Site Survey 

This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete for 
your terminal. 

Switch Client Modes 

The PowerNet Twin Client normally operates in thick mode, which provides direct 
connection to Telnet hosts. It can also operate in thin mode, through a PowerNet OpenAir 
server. Select the Switch Modes menu option to switch between thin and thick modes of 
operation. Note that the host socket address for the PowerNet OpenAir servers is 1800, 
which must also be changed in the Edit Host List menu described above. 

Run Client Emulator 

After all desired changes have been made, select the Run Emulator option to return to 
ain menu. Then press any key to establish the Telnet session and begin the Twin Client m

emulation. Refer to Starting a Telnet Session for further instructions. 
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Authoriz  

oftwa

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are m

AN segment with at 
least one access point within range of the terminal. 

 on which Twin Client Manager is installed has been used to 

ing PowerNet
Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 

re.  s

et: 
• A PC running Twin Client Manager is connected to the wire L

• The System ID of the PC
obtain a site license Authorization code from the Connect web site. 

To obtain the System ID of the Twin Client Manager, click on the Authorization optio
in

n 
 the Tools menu, as shown below. 

 

 

The Authorization window is displayed as shown below. 
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Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
op of the page. Follow the directions on the web site. 

use, and the number of 

Click on the D

Authorization icon at the t

Authorized Terminals 
The number of terminals authorized, the number of terminals in 
terminals remaining is provided in the Authorized Terminals box on the lower left side of 
the screen. 

etails button to number the options in the screen below in the order of your 
priority. 
 
Note: The terminal may or may not be able to utilize the Formatter feature depending on 

its Authorization codes. 
 

 
 

Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an Authorization 
ode for a terminal. This method does not utilize Airloader, as does the other method. 

 
Click on this button, manually enter your mac address in the screen that appears, and 
click on OK. This enables you to generate individual Authorization codes. 

c
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Adding Licenses 
The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client Manager. (i.e. Twin Client Manager is licensed for 10, and the 

er pucustom rchases another 10 licenses to make a total of 20.)   

From Twin Client Manager, choose Authorization from under the Tools menu. Click on 
the Add Licenses button.  

 

 

A pop-up box appears with the Machine ID and a space for the additional license’s 
Authorization code. Enter the additional license’s Authorization code and click on OK. 

Use the Machine ID in the pop-up box instead of the original Machine ID to get your 
Authorization code.   
 
If adding users, click on the Add Licenses button before generating the Authorization 
code to get the most current Machine ID. 
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Transferring Licenses 
 

The Transfer Licenses feature is used when moving a site license from one PC to another. 
After Twin Client Manager is installed on a new PC, you will need the System/Machine 
ID for it.   
 
From Twin Client Manager, select Authorization from under the Tools menu. 
 
Click on the Transfer Authorization button on the old PC. You will be asked for the 
new System ID. Enter this new System ID. It will generate an Authorization code for the 
new PC's Twin Client Manager.  
 

 
 
Note: This feature only works if there are licenses remaining on the old PC.  
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Listing 
 
Click on the Listing button to view Authorization codes used along with corresponding 
serial numbers. 
 
The Authorization codes used along with their corresponding serial numbers will appear. 
 

 
 

Click on OK when finished. 

Click on the Close button when finished. 
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Chapter 5 • Advanced Setup 
The PowerNet Twin Client permits the customization of all aspects of terminal operation 
without custom programming. This chapter describes all of the advanced setup options. 
Additional advanced customization features, using the Object Editors, are described in 
Chapter 6. 

Selecting the Advanced Setup 
The Twin Client Manager is installed in the Standard Setup mode. To change to the 
Advanced mode, click on the View menu and then on Advanced. 
 

 

As a result, a new set of tabs is displayed, as shown below. 
 

 

The following sections in this chapter describe each of the tabs and the options within 
each tab. 
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Customizing the Keyboard  
Clicking on the Keyboard tab displays the setup options related to the terminal keyboard 
and its operation. 
 

 
 

End Key 
This scrolling list selection is used to set the terminal key that terminates both the host 

 is used to set the keystroke to be sent automatically by the 
ld on the terminal is filled with keyed input. That is, if an input 

connection and the wireless session. The default is PF10. 

Auto Send Key 
This scrolling list selection
terminal when an input fie
field is 9 characters long, and 9 characters are manually keyed into the field, the Auto 
Send key is automatically transmitted with the 9 characters. The default is tab. Selecting 
noop disables this feature. 

Note: Selecting the Length Check option on the Scanner tab disables the Auto Send Key. 
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Case Conversion  
This scrolling list selection allows automatic conversion of keyed input to upper or lower 

ning no conversion takes place.  

f PowerNet Twin Client allows for custom keyboard development. For 
example, the tab key can changed to generate a PF4. This is an advanced integration tool 

 

 used to assign a key sequence to a specific terminal key. For example, the 
PF1 key can be set to generate a sequence such as receiving. This is an advanced 

its use is described in Chapter 6. 

This scrolling list selection controls the transmission characteristics of the VT emulation. 
tes an individual transmission. In block mode, a 
control key, such as Enter or a PF key, is depressed. 

T, 

llection timer value in the Timers tab should be set 
to between 30 and 50 milliseconds for maximum performance. 

) 
re of 

 field prior to keyed or scanned data input. The default value is disabled 
(unchecked). 

Clear First (3270 only) 
This check box option enables (checked) or disables (unchecked) the automatic erasure of 
all data in a field prior to keyed or scanned data input. The default value is disabled 
(unchecked). 

Serial Input 
This check box option enables (checked) or disables (unchecked) the viewing of the 
terminal screen in hyperterminal. 

Advanced (3270 only) 
Clicking on the Advanced button brings up the Advanced 3270 Keyboard screen and 
provides a variety of special key generation options. This is an advanced integration tool 
and its use is described in Chapter 6. 

case. The default value is none, mea

Mapping Object  
This feature o

and its use is described in Chapter 6. 

Macro Object (VT Only)  
This feature is

integration tool and 

Mode (VT Only) 

In char mode, each keystroke genera
transmission takes place only after a 
The block mode is more efficient. Refer to Chapter 6, Advanced Display Options for V
for more details on setting block mode operation. 

Note: When set to char mode, the Co

Auto EOF (3270 only
This check box option enables (checked) or disables (unchecked) the automatic erasu
all data in a
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Customizing the Display 
Clicking on the Display tab shows the options related to the terminal display and its 
operation. 

 
 

Quadrant Mode  
This scrolling list option defines the rules by which the terminal display is positioned 

larger host display. As defined by Tw
in 

the in Client, quadrants are fixed position 

 g and Twin Client simply centers the current host 

 sing. However, input fields that cross quadrant 
f the current input 

 Hard is the same as Soft except the viewing keys are disabled.  

"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processin
input field in the terminal display.  

On enables quadrant proces
boundaries result in a shift to the left in order to locate as much o
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 
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 Lock locks the ter
(x,y) coordinates 

minal display origin (upper left corner) to fixed row and column 
in the host display. The coordinates are zero-based.   

hos

e terminal display in full screen increments. For example, given a 16-
, the screen is scrolled left and right 16 columns at a time. 

n selects the display character mapping and the translation table 

 is not correctly 
translated, visit the Connect web site at http://www.connectrf.com

Scroll Mode  
This scrolling list option selects the rule used for moving the terminal display within the 

t display using the viewing keys. 

 Half scrolls the terminal display in half-screen increments. For example, given a 16-
column screen, the screen is scrolled left and right 8 columns at a time. 

 Full scrolls th
column screen

Language 
This scrolling list optio
used for error messages displayed on the terminal. The default value is English. The file 
umsgs.txt, which is installed with PowerNet Twin Client, contains all of the current 
language translations. 

In the event a specific language is not translated, or if a specific message
 and check the Support 

e issue has not been addressed, email page for a related Tech Note. If th
support@connectrf.com and request a Product Change Request (PCR). 

anner in which the cursor is displayed on the 
. 

Underscore (_) 
 

odify the displayed character set. This is an advanced integration 
cribed in Chapter 6. 

d to build session automation scripts, and is an advanced integration 
n Chapter 6. 

This feature is used to re-format the host display onto the terminal display. This is an 
advanced integration option and is described in Chapter 6. 

Cursor Appearance 
This scrolling list option selects the m
terminal. The default value is hard
Type Appearance 
Soft Blinking 
hard Blinking Block     
hide None 

Mapping Object 
This feature is used to m
option and its use is des

Dialog Object 
This feature is use
option described i

Formatter 
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Relocation Group 
This option group allows rows of the host display to be relocated automatically. This 
option is particularly useful when the application generates important error messages on a 
specific row that is not necessarily within the terminal's display area. 

Source  

Defines the starting row (zero-based) in the host display that is relocated to the 
destination row of the host display. The default is zero (0). 

Destination  

Defines the starting source row location (zero-based) in the host display. Default is zero 
(0). 

Row Count 

Specifies the number of host display rows to be relocated, starting with the row defined 
by the Source option and continuing from top to bottom of the display. The default, zero 
(0), disables row relocation. 

Move Blank  

This check box enables unconditional relocation (checked), or enables relocation only 
when data is present on the source row or rows (unchecked). The default is unchecked. 

Reverse Video 
This check box enables (checked) or disables (unchecked) the processing of the reverse 
video display attribute on the terminal. The default value “default” is on (checked). 

Wait Message 
This check box enables (checked) or disables (unchecked) the display of the message 
Waiting for Data on the terminal display. This message is used to indicate that the 
terminal has transmitted data to the host application and is waiting for a response. The 
default value is enabled (checked). 

Default Data (3270/5250 only) 
This check box enables (checked) or disables (unchecked) editing of data present in the 
current input field prior to entry of new data by the terminal operator. 

Font Size 
Font options chosen here are small, medium, larger, and largest. 
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Bold Font 
This check box enables (checked) or disables (unchecked) the display of characters in 
bold font.  

Advanced (VT only) 
This button accesses setup options for controlling all aspects of VT display attribute 
mapping and masking. This is an advanced integration tool and its use is described in 
Chapter 6. 

Customizing the Scanner 
Clicking on the Scanner tab shows the options related to the terminal scanner and its 
operation. 

 

Send Key 
This scrolling lis
data. The list of keys depends on the type of emulation in use. The noop key in
that no automatic control key will be sent. The default value is Enter. 

t option defines the control key automatically transmitted with scanned 
dicates 
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Scan Ahead 
This scrolling list option defines the number of scans that can be transmitted by the 
terminal without a response from the host system. The maximum is 24, and default is 1. 
 
Set to 0, scan ahead is disabled and you cannot scan again until the host 
response has been received.  
Set to 1, there is no scan ahead limit. 
Set to 2 and above, and the software will let you scan that many times 
until a host response is received. So if you set it for 3, it will allow you to 

Length Check 
 
With Length Check off, and Auto Enter key set to "noop": Keyed or scanned input 
that is equal to or greater than the field length results in an error "Entry Too Long" and 
no data is transmitted. 
 
With Length Check off, and Auto Enter key set to anything other than "noop": 
a.   Keyed input equal to the field length: The data and the specified Auto Enter key are    
     transmitted. 
b.   Keyed input greater than field length: This is not possible, due to a) above. 
c.   Scanned input equal to or greater than the field length: The data is transmitted. If the  
      data is greater than the field length, that data is distributed among subsequent              
     input fields and the Scan Termination key is transmitted (unless it is set to "noop"). 

With Length Check on: The Auto Enter key and its functionality are disabled for both 
scanned and keyed input. 
 
There are specific functionalities related to the various settings of length checking and the 
Auto Enter key. Setting the Auto Enter key to "noop" disables the Auto Enter function 
(i.e., automatic transmission of data when the field is filled or overfilled) for both 
scanned and keyed input. When it is set to anything other than "noop", keyed and 
scanned input is distinguished and the Auto Enter key is effective only for keyed input. 
Scanned data that is equal to or greater than the field length is terminated with the Scan 
Termination key instead of the Auto Enter key. 

Note: Enabling Length Check disables the Truncation option (described below). 

scan only 2 more times before the host responds to the first scan. 
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Truncation  
This check box option enables (checked) or disables (unchecked) the automatic 
truncation of scanned data that is greater than the length of the input field. With both 
Truncation and Length Checking disabled, oversized scans are automatically applied to 
subsequent input fields as needed. If either option is enabled, this automatic application is 
disabled. The default value is disabled (unchecked). 

Stripping 
This scrolling list option controls the rule for automatically removing trailing spaces and 
underscore characters. The rules are defined as follows: 

Rule  Operation 
off  No stripping is performed. 
space  Trailing spaces are stripped. 
score  Trailing underscores are stripped. 
both  Both trailing spaces and underscores are stripped. 

Binary-128 
This check box enables (checked) or disables (unchecked) the processing of binary code 
128 bar codes on the terminal. The default value is enabled (checked). 

Caution: If this option is disabled and binary-128 barcodes are used, the results are 
unpredictable. 

Data Mapping, Data Editor, and Decoder Control 
These are advanced integration tools and are described in Chapter 6. 

Scanner Type 
This scrolling list option defines the type of special scanner attachment in use, if present.  

External Scanner Setup 

RF terminals can be ordered with an Internal scanner or they can support an external 
scanner. The external scanner is connected to the bottom of the terminal through the 
serial port. This requires the RS232 adapter be installed. The external scanner can be 
made to work even if an internal scanner is present. However, scanner decoder controls 
only apply to the internal scanner as the user only has access to the internal decoder. 
 
The external scanner must be a serial based scanner. These are scanners that have on 
board decoder hardware/software and output their signals by normal RS232 signaling 
methods. These external scanners are controlled by their respective manufacturers’ 
program controls provided in the manual accompanying the scanner from the 
manufacturer. 
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The serial data stream, which the scanner outputs, needs to be in specific data format and 
speed. The RF terminal user manual has the setup for some popular scanners in this 
manual. It also includes the required bar codes to setup these scanners. 

The following is an example of a setup for an RF terminal. 

The order in which to set up the scanner is:  

1 - (SET RS-232C DEFAULTS)  

2 - (SET ALL DEFAULTS)  

3 - RS-232 HOST BAUD RATE (9600)  

4 - RS-232 HOST PARITY (NONE)  

5 - RS-232 HOST DATA TRANSMISSION FORMATS (<DATA><SUFFIX>)  

6 - RS-232 HOST PREFIX/SUFFIX VALUES (SUFFIX)  

7 - RS-232 HOST PREFIX/SUFFIX VALUES (<1><0><1><3>) 

Setting Log Levels 
The terminal maintains a logging facility that can be used by Technical Support and 
Engineering to assist in problem resolution. These levels should always be set to zero (0).  
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Customizing Timers 
Clicking on the Timers tab shows the options related to the terminal timers, as shown 
below. 

 

Timers Group 

Radio 

This numeric input field defines the length of time, in seconds, during which the terminal 
activates the radio and waits for a response from the host application. After the time is 

on the terminal. The default value is 120. 

This numeric input field defines the length of time, in seconds, during which the 
terminal’s display backlight remains on after keyboard or scanner input. When set to a 

rminal turns on the backlight for the amount of time specified. 
ttery life. The default value is 5. 

exceeded, an error message is displayed 

Power  

This numeric input field defines the length of the time, in seconds, after which inactivity 
of the scanner, keyboard, or radio results in a power saving shutdown of the terminal. 
The default is 300 (5 minutes). 

Backlight  

value other than 0, the te
Backlight use reduces ba
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Keepalive (3270/5250 only) 
This option group circumvents host application connection timeouts by automatically 
generating the selected keystroke when the terminal is inactive for the specified period of 
time, in minutes. 

Collection Timer (VT only) 
This scrolling list option specifies the number of milliseconds the terminal waits for 
inactivity from the host before processing received data. This feature is useful in 
situations where the application and network latency fragments host transmissions to the 
terminal, and also when host applications generate intermediate displays that are not 
used. The default value is 100.  

Note: For maximum performance, adjust the collection time to 30-50ms when Mode on 
the Keyboard tab is set to char. 

Customizing Alarms 
Clicking on the Alarm tab shows the options related to the terminal alarm mechanisms, as 

w. shown belo

 
 

Mode  
This scrolling list option defines the operation of the audible alarm and scanner light on 

 

the terminal. Default is bell.  
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• Off disables the audible alarm. 

ouble beep and the scan indicator light as the alarm.  
dible alarm as a single beep.  
le beep and the scan indicator light as the alarm. 

 audible alarm. The default is setting is hi. 

ake a distinction between 
de tones when the Mode is set to spec1 or spec2. 

 sound in milliseconds. The 

inal's factory-set default which is terminal model dependent. The 

host transm

es generated when the 
scan decoder successfully identifies a symbology. 

decode, in milliseconds. The default is 300. 

• Bell enables the audible alarm as a double beep. 
• Flash enables the scan indicator light as the alarm - no audible alarm sounds.  
• Both enables the d
• Spec1 enables the au
• Spec2 enables a sing

Volume  
This scrolling list option set the volume of the

Duration & Frequency 
The next two options, duration and frequency, are used to m
alarms and scan deco

Duration  

This numeric entry field defines the length of the alarm
default is 150. 

Frequency  

This numeric entry field defines the frequency of the audible alarm in Hertz. The default, 
zero (0) selects the term
default value is 2048. 

Allow Multiple  
This check box enables (checked) or disables (unchecked) multiple alarms in a single 

ission.  

Scan Duration & Frequency 
The next two options, scan duration and frequency, relate to the ton

Scan Duration  

This numeric input field defines the duration of the tone generated by a successful scan 

Scan Frequency  

This numeric entry field defines the frequency of the scan decode tone in Hertz. The 
default, zero (0), selects the terminal's factory-set default which is terminal model 
dependent. 
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By Attribute (3270 only)

e default), pen for the light pen attribute, num for numeric 
 for high intensity attribute, and hal for high intensity and light pen attributes. 

s (checked) or disables (unchecked) the processing of the field 
ttribute into audible alarms for all protected fields on the display. 

nprotected  

his check box enables (checked) or disables (unchecked) the processing of the field 
attribute into audible alarms for all unprotected fields on the display. 

lternate (5250 only)

his check box enables (checked) or disables (unchecked) the conversion of a single digit 
character at a specified row and column on the 5250 display into the corresponding 

umber of audible alarms. 

ow  

his numeric input field specifies the zero-based row number in the 5250 display of the 
lternate alarm digit. 

Column  

ecifies the zero-based row number in the 5250 display of the 

 

 

This scrolling list entry defines how 3270 field attributes can be used to generate alarms. 
The choices are off (th
attribute, hi

Protected  

This check box enable
a

U

T

A
T

n

R

T
a

This numeric input field sp
alternate alarm digit. 

 

 

 

 

 

 

 

 

  PowerNet Twin Client Reference    •   May, 2006 5-14



  Customizing Printers 

Customizing Printers 
Clicking on the Printer tab shows the options related to the terminal printer, as shown 
below. 

 

Type  
This scrolling list option defines the type of printer attached to the terminal. The default 
is none. 

Init Object 
This feature allows printer initialization commands to be sent to the terminal immediately 

 Key (3270,5250 only) 
tion direct control over the 

field is a decimal value that corresponds to the ASCII-converted 
value of an EBCDIC character generated by the host application. When the Flag Byte is 
set to a non-zero value, the terminal checks the host display for the value at the specified 

after the terminal establishes a session. This is an advanced integration tool and is 
described in Chapter 6. 

Flag Byte, Row, Column, and Clear
This group of options provides 3270 and 5250 host applica
terminal printer. See the Start and End later in this section for an alternate method. VT 
applications rely on standard escape sequences for the printing function. 

Flag Byte 

This numeric input 
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row and column (see Flag Row and Flag Column below). If the Flag Byte is present, all 
data in the display that follows the Flag Byte is routed directly to the printer, up to the 

This numeric input field specifies the row (zero-based, range of 0 to23) where the Flag 
e) is located. 

This numeric input field specifies the column (zero-based, range of 0 to79) where the 

inal after printing 

ttached to the terminal. The default value is 
 indicates that this option is not in use.  

Specifies a unique character sequence that terminates collection of data from the host 
display area for transmission to the printer attached to the terminal. The default value is 
blank which also indicates that this option is not in use. 

Start and End Convert (3270/5250 only) 
This option group provides for conversion of print data collected with the Start and End 
option group from ASCII characters in hexadecimal format (0-9 and A-F) to binary. The 
feature allows binary data that might otherwise interfere with the emulation to be 
included in the display area. The host application is responsible for generating the 
hexadecimal data. 

Start Convert  

Specifies a unique character sequence (ASCII-converted) within the print data collected 
with the Start and End options that indicates the subsequent character pairs are 
hexadecimal values that are converted to binary. A blank value, default, indicates that this 
option is not in use. 

next occurrence of a Flag Byte value in the display or else the end of the display. 

Flag Row  

Byte (defined abov

Flag Column  

Flag Byte (defined above) is located. 

Clear Key  

This scrolling list option defines the keystroke transmitted by the term
has completed. Set the key to noop to disable transmission.  

Start and End (3270 and 5250 only) 
This option group provides the host application direct control over the terminal printer. 

Start 

Specifies a unique character sequence that, when encountered in the host display, 
indicates that all subsequent characters up to but not including the End character 
sequence are to be transmitted to the printer a
blank which also

Note: The print data limit is 1.5 K. 

End  
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End Convert  

Specifies a unique character sequence (ASCII-converted) that te
conversion. Default, blank, indicates that this option is not in use

rminates binary 
. 

LXE Option (3270/5250 only) 
This check box enables (checked) or disables (unchecked) the processing of print data 
embedded in the datastream according to LXE printing rules. 

Convert Flag Byte and Conversion (3270 only) 
This option group defines the conversion of a single character (Convert Flag Byte) found 
in the 3270 print data, to a printer control sequence defined by the Conversion scroll list. 

Convert Flag Byte 

This numeric input field defines an ASCII value, in decimal format, that will be 
converted to a printer control sequence as defined by the Conversion option. The default 
value is zero (0), which disables conversion. 

Conversion 

Specifies what the Flag Byte is converted to. The options are crnl, cr, and nl, which 
represent ASCII carriage return new line, carriage return, and new line, respectively. The 
default value is crnl. 
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Miscellaneous Customizations 
Clicking on the Misc tab shows the following options window. 

 
 

Extended Command Group (3270 and 5250 only) 

This option group provides 3270 and 5250 host applicati
command set available to VT applica
of the Extended Commands. 

ons with the same extended 
tions. Refer to Chapter 6 for a detailed description 

Start  

play, 
dicates that all subsequent characters up to but not including the End sequence, are to 

ption is not 

mand. 

disables (unchecked) the transmission of all fields 
et. When disabled, only unprotected fields are 

fields with the MDT set. 

Specifies a unique character sequence that, when encountered within the host dis
in
be interpreted as an Extended Command. Default, blank, indicates that the o
in use. 

End  

Specifies a unique character sequence that terminates the Extended Com

Data Stream Group (3270 only) 

Send All MDT  

This check box enables (checked) or 
with the MDT (Modified Data Tag) bit s
transmitted. The default is enabled, which transmits all 
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Send NULL  

This check box enables (checked) or disables (unchecked) the transmission of NULL 
characters to the host system. The default value is disabled. 

Note:  For AS400 hosts, this option must be checked.  

Enable TN 3270E 

If this box is checked, will negotiate using TN3270E rules (see RFC 2355). If this box is 
unchecked, will not negotiate TN3270E and will use IBM 3278 Mod 2. 

Answerback (VT only) 
This text input field defines the response returned to the host application when the 
answerback command (as defined under VT emulation) is received. If this value is left 
blank, the terminal automatically returns an ASCII string corresponding to the emulation 
in use (vt100 or vt220). Non-graphic characters may be embedded in the answerback 
field using the escape sequence  \nnn , where the backslash is followed by three digits 
representing the octal value. Refer to Chapter 9, ASCII Character Set Octal Values. 
 
$1 = terminal number. IP terminals = last two octets of the IP address.  
Spectrum One = 065-511 

Inserting the sequences “$A”, “$B”, “$C”, and “$D” into the answerback string results in 
a substitution of four octets, three octets, two octets, and the last octet of the terminal IP 
address, respectively, as shown below.  

$A - all four octets of the IP address (206.183.067.226) 
$B - the last 3 octets (183.067.226) 
$C - the last 2 octets (067.226) 
$D - the last octet (226) 

Given a terminal with an IP address of 206.183.67.226, the following examples 
demonstrate how substitution and non-graphic escape sequences are processed.  
 
Answerback   Data Sent in Response to Answerback Command 
Hello World  Hello World 
$A   206.183.067.226 
RF$A   RF206.183.067.226 
RF$A\015  RF206.183.067.226<carriage return> 
$B   183.067.226 
RF$B   RF183.067.226 
RF$B\015  RF183.067.226<carriage return> 
$C   067.226 
RF$C   RF067.226 
RF$C\015  RF067.226<carriage return> 
$D   226 
RF$D   RF226 
RF$D\015  RF226<carriage return> 
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Chapter 6 • Advanced Integration 
This chapter describes the use of the advanced integration features built in to the 
PowerNet Twin Client. These features make it possible to tailor Twin Client operation to 
meet special customer requirements without custom programming. 

Integration objects are used to implement the Twin Client advanced integration 
capability. An editor is used to create and modify each object, and the objects are 
associated with a terminal configuration using the Advanced setup options described in 
the previous chapter. The objects then become part of the terminal's software 
configuration and as a result are supported by the powerful Auto-Configuration tools 
described in the Chapter 8 section, Airloader Auto-Configuration. 

Clicking on the Object Editors menu of the PowerNet Twin Client Manager displays the 
editor menu. 

 

The following sections describe the use of each object, how to create the object, and how 
to assign the object to a terminal configuration using the Advanced Setup options. 

A detailed description of the Extended Commands, which are used by applications to 

Keyboar
 used to change the functionality of the terminal 
ten used to simplify keyboard usage and reduce operator 

-training requirem

dynamically control the terminal scanner and keyboard, is included in this chapter. The 
advanced emulation-specific configuration options to which the previous chapter refers 
are also described here. 

d/Mapping  
The Keyboard/Mapping object is
keyboard. This feature is most of
workload. It is also used to reduce re ents when introducing new 
terminal models. 
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The need for keyboard mapping is a result of the size-restricted keypads common to all 
portable terminal devices. Compensating for the physical limitations, the manufacturer 
uses state modifier keys to expand the functionality of the keypad. As a result, many keys 
(e.g., the Up-Arrow key) require the operator to press two or more keys to emulate a 
single keystroke. Because many applications tend to rely heavily on a small group of 
keys, it is advantageous to map those frequently used keys to single key strokes, thus 
increasing both productivity and user acceptance. 

Creating the Object 
Create the object by clicking on Object Editors, then click on Keyboard/Mapping. T
Unitech keyboard appears.  

he 

 

The Keyboard Mapper screen provides a mock-up of a keypad on the left side of the 
window, and options for key remapping on the right. By clicking on a key on the keypad 
mock-up, the available options that apply to that key appear on the right. For example, 
clicking on the key at the lower right corner of this model changes the display as follows. 

 

The first column on the right side of the window, entitled Transmit, defines the emulation 
key assigned to the highlighted keypad button in each of the available keyboard states 
(unshifted, shifted, alpha lock, etc.). Each modified key state is initially blank, indicating 
that the PowerNet default is in effect and no changes will be made to that key or its Mode 
of operation. Refer to Chapter 10 for the table of default PowerNet key assignments for 
the Unitech terminal. 

  PowerNet Twin Client Reference    •  May, 2006 6-2



  Keyboard/Mapping 

 

After a key is selected, the Mode options 
Mod en by the selected key combination. 

change depending on the key selection. The 
e column defines the action tak

 

The table of mode options, and their effect, is as follows.  
 

xmit Transmits the key. 

noop Disables the key. 

edleft Non-destructive backspace (moves) to the left of the cursor within a field. 

 a field. 

lhelp Displays terminal ID, date, time, and terminal software version number. 

scan Activates the scanner. 

Saving and Assigning the Object 
Save the object by clicking on F

edrite Non-destructive space (moves) to the right of the cursor within a field. 

edbksp Destructive backspace (moves) to the left of the cursor within

edeeof Erases from current position to end of field. 

edefld Erases entire field. 

ile, and Save As, and then enter a name. For the 
purposes of this example, the name is vt.  
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Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on 
the  button at the upper right corner of the Keyboard Mapper window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Keyboard tab, then on the Mapping 
Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is booted, the new configuration will be downloaded automatically and
the keyboard mapping will take effect. 

 

Keyboar
bject is used to assign sequences of characters to the VT 

programmable function keys. Using this feature, strings of characters can be assigned to a 
single keystroke.  

Create the object by

d Macros 
The Keyboard/Macro o

Creating the Object 
 clicking on Object Editors, then Keyboard/Macros, and then enter 

 is vt. a file name. For the purposes of this example, the name
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Click on the Open button, and then click on the Yes button to create the new file. 

 

The Notepad utility is then invoked. The Keyboard/Macro object is a text file with one 
entry per line. Each entry uses the following format,  
<keyname>=<macro string>; 

where <keyname> is PF1 to PF24, and <macro string> is the macro text assigned to that 
specific key. For example, to assign the text "vt100" followed by a carriage return to the 
PF9 key, the entry is: 

 

 

Note: \015 represents the octal value for “carriage return”. Refer to Chapter 9, ASCII 
al Values. 

Save the object by clicking on F

Character Set Oct

Saving and Assigning the Object 
ile, then on Save, and then on Exit, which returns to the 

Twin Client Manager menu. 

ation 
from t F
Next, assign the object to a terminal configuration by opening a terminal configur

he ile menu. Click on the advanced setup Keyboard tab, then on the Macro Object 
list button, and finally on the object name. 
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Save the updated terminal configuration by clicking on File, and then Save. The next 
time th d, the new configuration will be downloaded automatically and 
the key

Scanner/Data Mapping  
The Scanner/Data Mapping object defines barcode sequences that, when encountered in 
scanned data, are automatically converted to emulator keystrokes. This feature can be 
used to ate keyboard entry by the operator. That is, instead of pressing 

mapped to the 

e terminal is boote
board macro will take effect. 

 reduce or elimin
the PF3 key to access a help screen, the operator scans a barcode that is 
keystroke. 

Creating the Object 
Create the object by clicking on Object Editors, then Scanner Data/Mapping, and then
enter a file name. For the purposes of this example, the name is vt. 

 

 

Click on the Open button, and then click on the Yes button to create the new file. 

 

The Notepad utility is then invoked. The Scanner/Data mapping object is a text file with
one entry per line. Each entry uses the following format, 

 

<barcode>=<keystroke>; 
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where <barcode> is the scanned

pings, including the mapp

 barcode and <keystroke> is the keystroke to send when 
the barcode is scanned. The following example object demonstrates three scan data 
map ing of barcode $H to the PF3 keystroke.  

 
Note: The Scanner/Data Mapper accepts octal notation. See the example below. 

 

mple s r da ject 

rmat is
e ned =  

or 5250 d 3270, ys can Pf1-Pf24, en
ar, sysre  
hen a b ode is ntaining 3" a Pf4 is se

the host 

TB=tab; 

#When a barcode is scanned containing "thisisatab" the tab is 
sent 
#with octal values obtained from a standard ASCII chart 
thisisatab=\009; 
#For an enter 
thisisanenter=\015; 
#For pf1 
*=\033[OP\015; 

Saving and Assigning the Object 
Save the object by clicking on F

# 
# Sa canne ta mapping ob
# 
#Fo : 
# barcod scan  send this;
#F
cle

an
q.

 only AID ke be sent ter, 

#W arc scanned co  "00125 nt to 

001253=pf4; 
ENT=enter; 

#Vt100 examples 
#For a tab 

ile, then on Save, and then on Exit, which returns to the 
Twin Client Manager menu. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Scanner tab, then on the Data Mapping 
Obje t list button, and finally on the object name. c

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is booted, the new configuration will be downloaded automatically and 
the scanner data mapping will take effect. 
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Scanner/Data Editing  
The Scanner/Data Editing object defines the rules for recognizing barcode patterns a
performing automatic manipulations on the barcode before it is transmitted to the host 
application. This feature is most often employed when upgrading wedge-based syst

nd 

ems. 

Creating the Object 
Create the object by clicking on Object Editors, then Scanner/Data Editing. 

 

Barcode recognition is based on the Size (length) and Recognition specifiers. Once the 
pattern is recognized, Operation specifiers manipulate the barcode. 

The recognition specifiers consist of the four characters shown in the following table: 
 A Alpha character 

N Numeric character 
* Any character 
= Must match next character 

The operation specifiers consist of the following constructs: 
 X Delete character 

* Copy as is 
( ) Substitute 
““ Insert 

How these specifiers identify and manipulate data is illustrated below. 
 
Barcode Size Recognition Operation Result 

PN-1245 7 AA=-NNNN “F”******* FPN-1245 

5A5567BBAT 10 ********** **********”M” 5A5567BBATM 

TGR87 5 =T=GAN* **(S)** TGS87 

78-RHG 6 NN=-AAA **X*** 78RHG 

  PowerNet Twin Client Reference    •  May, 2006 6-8



  Scan/Decoder Control 

Saving and Assigning the Object 
Save the object by clicking on File, and Save As, and then enter a name. For the 
purposes of this example, the name is vt.  

 

Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on 
the  button at the upper right corner of the Scan Editor window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Scanner tab, then on the Data Editor 
Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 

Scan/Decoder Control 
The Scan/Decoder Control object modifies the operation of the scan decoder in the 
terminal. Any of the supported symbologies can be enabled or disabled, and all of the 
parameters associated with a specific symbology can be modified to meet specific 
customer requirements. 

This feature is used primarily to reduce errors and increase performance. For example, a 
terminal used in a receiving application can be restricted to symbologies used only in the 
receiving department, thus reducing the opportunity for scan decoder errors and, in many 
cases, increasing scanner performance. As another example, the scan decoder can be 
instructed to return a successful scan only when the barcode is of a certain length. As a 
result, the opportunity for a scan decoder error is further reduced. 

time the terminal is booted, the new configuration will be downloaded automatically and 
the scan data editor object will take effect. 
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PowerNet Twin Client also allows the scanner to be controlled dynamically by the 
application. This is accomplished through the use of the Extended Command set, which is 
described later in this chapter. 

Creating the Object 
Create the object by clicking on Object Editors, then Scanner/Decoder Control. 

 

The check box next to the symbology enables (checked) or disables (unchecked) the 
symbology. The options for a specific symbology are available for modification by 
highlighting the select symbology. 

Saving and Assigning the Object 
the object by clicking on FSave ile, and Save As, and then enter a name. For the 

purposes of this example, the name is vt.  
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Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on 
the  button at the upper right corner of the Decoder Control window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Scanner tab, then on the Decoder 
Control Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is booted, the new configuration will be downloaded automatically and 

Display/
The Display/Mapping object is used to correct variations between application character 
sets and the terminal display character set. The terminal display uses the ISO-8859-1 font 
set, which is an international standard adhered to by most, but not all, applications. The 

Create the object by clicking on O

the scan decoder control object will take effect. 

Mapping 

display mapping is used to resolve any discrepancies. 

Creating the Object 
bject Editors, then Display/Mapping, and then enter a 

file name. For the purposes of this example, the name is vt. 
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Click on the Open button, and then click on the Yes button to create the new file. 

 

 is then invoked. The DispThe Notepad utility lay/Mapping object is a text file with one 
entry per 

<application char>=

where <applica  itted by the 
host application, and terminal 
display character, fo  for both 
ISO-8859-1 and the

For the purposes of o an 
umlaut ë (0xEB) wit
hexadecimal values

line. Each entry uses the following format, 

<ISO-8859-1 char>,xlat; 

tion char> is the hexadecimal value of the character transm
 <ISO-8859-1 char> is the hexadecimal value of the desired 
llowed by a comma, the word xlat, and a semicolon. Tables
 ASCII character sets are in Chapter 9. 

this example, the English character e (0x65) will be converted t
h the entry shown below. Note that that the two character 
 must be preceded by 0x. 

 

ssigning the Object Saving and A
Save the object by clicking on File, then on Save, and then on Exit, which returns to the 
Twin Cl

Next, as j nfiguration 
from the 

ient Manager menu. 

sign the ob ect to a terminal configuration by opening a terminal co
File menu. Click on the advanced setup 

tton, and fina
Display tab, then on the Mapping Object

ly on the object name. 
 

list bu l
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minal configuration by clicking on Save the updated ter File, and then Save. The ne
booted, the new configuration will be d

xt 
time the terminal is ownloaded automatically and 
the dis g

Display/For
The Display/Format er to 
use, without modify on of 
this important integration feature. 

Printer/Init 
Th r at 
the m

C
Create the object by

play mappin  object will take effect. 

matting 
ting object is used to make the host application interface easi
ing the host application. Chapter 7 is devoted to the descripti

e Printer/Initializ
 start of each ter

ation object is used to send initialization commands to the printe
inal session. It can also be used to test printer operation. 

reating the Object 
 clicking on Object Editors, then Printer/Init, and then enter a file 

name. oFor the purp ses of this example, the name is vt. 

 

Click on the Open button, and then click on the Yes button to create the new file. 
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The Notepad utility is then invoked. The printer/init object is a text file, allowing for the 
entry of printer-specific commands. Refer to the documentation provided by the printer 
manufacturer for instructions. 

Saving and Assigning the Object 
Save the object by clicking on File, then on Save, and then on Exit, which returns to the 
Twin Client Manager menu. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Printer tab, then on the Init Object list 
button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is booted, the new configuration will be downloaded automatically and 
the init object will be transmitted to the printer at the start of the next Telnet session. 

Dialog 
The Dialog object is a script used to automate difficult or repetitive user interactions with

e Object 

 
the host application. It can be used to create terminal screens, collect input, generate 
output, and make decisions based upon terminal keyboard or scanner input, and host 
application data. 

Creating th
Create the object by clicking on Object Editors, then Dialog. Commands selected from 
scrolling list on the right are added or inserted into the scripting area on the left using the 
click buttons between the two areas. The bottom left portion of the window is used to 
collect arguments for those commands that require them. 
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Commands and Arguments  

Commands control the actions taken within the script. They can be used to interact both 
with the host and the terminal, and to modify activity based on comparisons of both 
terminal and host data. The following tables describe each command. 

Goto Causes execution to begin unconditionally and immediately 
at the named target Label

Equals If the comparison is equal, branches to Label. Otherwise, 
execution continues with the next command. 

onditions of the comparison operator are true, 

(equal), != (not equal), > (greater than), and < (less than). The 
string value comparison operators, which treat the values as 

 
Commands 

Label Defines a target for the conditional branch commands Onfail, 
Equal, If, Host State, Host Scan, and the unconditional branch 
command, Goto. 

. 

On Fail Upon detection of a system error, execution continues at the 
named Label. 

0If If the c
branches to Label. Otherwise, execution continues with the 
next command. The numeric value comparison operators, 
which treat the values being compared numerically, are = 
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Commands 

 a value to one of up to 36 variables. 

 to or subtracts from the value of a variable. 

dds characters to the end of a variable. 

r. The 
ext line, 

board 

Host Off Terminates the TCP/IP connection to the host system. 

ns the host display for a value, and continues execution at 
e named label if the value is found. 

nditional branch 

ble. 

If the state of the session matches the value supplied, 
execution begins at the named Label. The possible values are 

active, meaning the host session has not been established, 
d plu, which means the host session has been established. 

nput Prompts the terminal operator to input data. 

ompts the terminal operator to input data, which will not be 

Exit Terminates execution of the dialog object. 

indicate the name of a variable. The character is normaLoglly 

character strings, are $= (equal) and $!= (not equal). 

Set Var Assigns

Change Var Adds

Concat A

Session Returns control of the session to the terminal operato
operator returns control to the dialog object, at the n
by pressing the key defined as the End Key in the Key
tab. 

Host On Initiates a TCP/IP connection to the host system. 

Host Scan Sca
th

Host Update Refreshes the host display. This command is used after data 
has been sent to the host that may change the display, and 
prior to using the Host Scan or Host State co
commands, or a Host Copy command. 

Host Send Transmits data and/or a keystroke to the host. 

Host Copy Copies characters from the host display to a varia

Host State 

in
an

Settle Allows time for the host application to settle. 

Term Enable Initializes the terminal configuration parameters. 

Term Clear Clears the terminal display of all characters. 

Term Display Puts a value or the value of a variable on the terminal display. 

Term I

Term No Echo Pr
echoed on the terminal display. 

Term Wait Waits for any input from the terminal. 

Term Logoff Terminates the connection to the wireless network. 

Sleep Suspends all activity for the specified number of seconds. 

Var Char Sets the character used internally by the dialog processor to 
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Commands 

 This command is used only when the first character of a 
mands 

o

ent Inserts documentation in the dialog object. 

s 

e mand. Click 

$.
value used in one of the conditional branching com
begins with a $. 

L g Writes a message to the terminal log. 

Comm

Adding Command

Th  scro t box on the right side of the window is used to select a com
on the desired command and then click on the 

lling lis
Add button to add the command to the 

dialog script. 

 

All commands that require arguments prompt for them in the box at the lower left side of 
the wind  Display command requires a row number 
and either a variable or a character string. In this case the display string is . 

ize of the box 

eting Commands 

Click on the desired dialog line on the upper left side of the window to highlight the line, 
then clic

ow. In the example above, the Term
Hello World

Note that the text entry field scrolls to the right so that text longer than the s
can be entered. 

Inserting and Del

k on the Insert button to insert a new command above the selected line, or click 
on the Delete tton to remove the line. bu
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Using Variables and Labels 

ides up to 36 variables to store temporary data collected during the 
executio
The dialog object prov

n of the script.  

 

These variables can be
If the comparison is true, execu

 compared to fixed values or other variables using the if command. 
tion branches to the specified label. 

 

ving and Assigning the Object Sa
vSa e the object by clicking on File, and Save As, and then enter a name. For the 

oses of this example, the name is vt.  purp
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Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on 
the  button at the upper right corner of the Decoder Control window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup D
li

isplay tab, then on the Dialog Object 
st button, and finally on the object name. 

 

nfiguration by clicking on Save the updated terminal co File, and then Save. T
he new configuration will be

he next 
time the terminal is booted, t  downloaded automatically and 
the log o ke ef

Extended Commands 
The host application can control the terminal's scanner and keyboard dynamically, while 

nded commands described in the following 

The form  commands that control the scan decoder are described in 

ODABAR Control 

Extended Com

SC>[?0;<state>;<minlen>;<maxlen>;0z 

• ate: . 0=disabled, 1=enabled. 
• Minlen: Minimum valid barcode length. Valid values are 1–54. 

dia bject will ta fect. 

the terminal is in session, by issuing the exte
sections.  

Dynamic Decoder Control 
at and content of the

the following sub-sections. 

C

mand: 

 <E

St  Disable/enable codabar scanning
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• xlen h. The maximum length must be greater 

CODE 11 Control 

ommand: 

pend>z 

• 
Min

ength must be greater 
than or equal to the minimum length. Valid values are from 4 to 54. 

it. Valid values are 0, 1, or 27. 

xtended Command: 

?2;<state>;<minlen>;<maxlen>;0z 

 0=disabled, 1=enabled. 
 valid barcode length. Valid values are from 1 to 54. 

 Specifies the maximum valid barcode length. The maximum length must 
 length. Valid values are from 1 to 54. 

and: 

<ESC>[?3;<state>;<minlen>;<maxlen>;<depend>z 

 0=disabled, 1=enabled. 

st 

• Depend: Disable/enable full ASCII code 39 interpretation. 0=disabled, 1=enabled. 

CODE 49 

Extended Command: 

<ESC>[?4;<state>;0;0;0z 

• State: Disable/enable code 49 scanning. 0=disabled, 1=enabled. 

CODE 93 

Extended Command: 

<ESC>[?5;<state>;<minlen>;<maxlen>;0z 

• State: Disable/enable code 93 scanning. 0=disabled, 1=enabled. 

Ma : Maximum valid barcode lengt
than or equal to the minimum length. Valid values are 1–54. 

Extended C

 <ESC>[?11;<state>;<minlen>;<maxlen>;<de

State: Disable/enable code 11. 0=disabled, 1=enabled. 
• len: Minimum valid barcode length. Valid values are from 4 to 54. 
• Maxlen: Maximum valid barcode length. The maximum l

• Depend: Number of check dig

CODE 128 

E

<ESC>[

 State: Disable/enable code 128 scanning.
 minimum

•
• Minlen: Specify
• Maxlen: 

be greater than or equal to the minimum

CODE 39 

Extended Comm

• State: Disable/enable code 39 scanning.
• Minlen: Specifies the minimum valid barcode length. Valid values are from  

1 to 54. 
• Maxlen: Specifies the maximum valid barcode length. The maximum length mu

be greater than or equal to the minimum length. Valid values are from 1 to 54. 
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• Minlen: Minimum valid barcode length. Valid values are 1–54. 
ter 

 Command: 

[?6;<state>;<minlen>;<maxlen>;0z 

aximum length must be greater 

• Disable/enable interleaved 2 of 5 scanning. 0=disabled, 1=enabled. 
Minimum valid barcode length. Valid values range from 1 to 54. 

ngth. Valid values range from 1–54. 

Extended Command: 

state>;0;0;0z 

• Sta I scanning. 0=disabled, 1=enabled. 
• Minimum valid barcode length. Valid values are from 4 to 54. 

xlen: Maximum valid barcode length. The maximum length must be greater 

• Maxlen: Maximum valid barcode length. The maximum length must be grea
than or equal to the minimum length. Valid values are 1–54. 

D 2 of 5 

Extended

<ESC>

• State: Disable/enable code 25. 0=disabled, 1=enabled. 
• Minlen: Minimum valid barcode length. Valid values range from 1–54. 
• Maxlen: Maximum valid barcode length. The m

than or equal to the minimum length. Valid values range from 1–54. 

INTERLEAVED 2 OF 5 

Extended Command: 

<ESC>[?7;<state>;<minlen>;<maxlen>;0z 

State: 

• Minlen: 

• Maxlen: Maximum valid barcode length. The maximum length must be greater 
than or equal to the minimum le

EAN-13 

Extended Command: 

<ESC>[?8;<state>;0;0;0z 

• State: Disable/enable EAN-13 scanning. 0=disabled, 1=enabled. 

EAN-8 

<ESC>[?9;<

• State: Disable/enable EAN-8 scanning. 0=disabled, 1=enabled. 

PLESSEY/MSI 

Extended Command: 

<ESC>[?10;<state>;<minlen>;<maxlen>;<depend>z 

te: Disable/enable code MS
Minlen: 

• Ma
than or equal to the minimum length. Valid values are from 4 to 54. 

• Depend: Specifies the number of required check digits. Valid values are 0, 1, or 2. 
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UPC-A 

Extended Command: 

[?13;<state>;0;0;0z 

>[?14;<state>;0;0;0z 

Disable/enable UPC-E0 scanning. 0=disabled, 1=enabled. 

able UPC-E1 scanning. 0=disabled, 1=enabled. 

• State: This flag should always be set to one. 
ifies if two character supplementals are enabled/disabled (only 

applies to transmit mode 1). 0=no codes with two character supplementals decoded, 

 to transmit mode 1). 0=no codes with five character supplementals decoded, 
 five character supplementals decoded. 

Specifies the supplemental transmit mode. 0=no supplementals 

le ignored. 

oders 

This command is used to disable all barcodes on the handheld. Typically this would be 
issued before turning on an individual barcode type just to make sure of the state of the 
active barcodes. 

<ESC>

• State: Disable/enable UPC-A scanning. 0=disabled, 1=enabled. 

UPC-E0 

Extended Command: 

<ESC

• State: 

UPC-E1 

Extended Command: 

<ESC>[?15;<state>;0;0;0z 

• State: Disable/en

Supplemental Barcode Handling (UPC/EAN) Options 

Extended Command: 

<ESC>[?12;<state>;<minlen>;<maxlen>;<depend>z 

• Minlen: Spec

1=codes with two character supplementals decoded. 
• Maxlen: Indicates if five character supplementals are enabled/disabled (only 

applies
1=codes with

• Depend: 
transmitted to host, supplemental enable/disable ignored. 1=only codes with the 
appropriate supplemental (from minlen/maxlen) decoded. 2=all codes sent as is, 
supplemental enable/disab

Disabling All Dec

Extended Command: 

<ESC>[?z 
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Input Mode Command 
The input mode parameter sent from the application controls (via the host application) 
whether the terminal accepts input from the keyboard, the scanner or both. The format of
this command is as follows: 

 

0 
(default) 

Scan and Key Data initially accepted from either the keyboard or 
scanner. Scanning, allowed on a partially keyed 
field, causes the keyed data to be discarded and the 
scanned data to be accepted. 

1 Scan or Key Data initially accepted from either the keyboard or 
scanner. Scanning is not allowed on a partially 
keyed field. If the operator clears the field then 
scanning is again allowed.  

2 Scan Only Data accepted only from the scanner. Use caution 
when using this command, bad barcode can block 
the user from completing input. 

3 Key Only Data accepted only from keyboard, the scanner off. 

Key Input Mode Command 
ed dynamically, while the terminal is in 
lows: 

e of the following. 
 

Mode Description 

1 Accepts alphabetic characters only. 

For example, to allow keyboard input of numeric characters only, use the following 
sequence: 
 <ESC>[!1;3z<ESC>[!2;2z 
(HEX equivalent: 1B 5B 21 31 3B 33 7A 27 5B 21 32 3B 32 7A) 

<ESC>[!1;<mode>z  

The mode parameter can be one of the following: 
 

Mode Action Description 

The processing of keyed input can be controll
session. The format of this command is as fol

<ESC>[!2;<mode>z  

The mode parameter can be on

0 Accepts characters between 0x20 and 0x7F. 
(default) 

2 Accepts numeric characters only. 

3 Accepts alphanumeric characters only. 
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To reset the terminal back to normal input, use the following sequence: 
 <ESC>[!1;0z<ESC>[!2;0z 
(HEX equivalent: 1B 5B 21 31 3B 30 7A 27 5B 21 32 3B 30 7A) 

Dynamic Font Change 
 

Where DoubleHigh and DoubleWide can each be either 0 or 1:  
<ESC>[!5;<DoubleHigh>;<DoubleWide>;z  
 
To set only Double High mode:  
<ESC>[!5;1;0;z  
 
To set only Double Wide mode:  
<ESC>[!5;0;1;z  
 
To set Double High, Double Wide mode:  
<ESC>[!5;1;1;z  
 

Advance

To restore normal fonts:  
<ESC>[!5;0;0;z 

d Display Options for VT 
The Advanced button in the advanced view Display tab is active when VT100 or VT220 
emulation is selected. This option group controls how display attributes are processed, 
and it can also be used to simulate block mode operation (see the Mode option 
description in the Chapter 5 section, Customizing the Keyboard). 

 

A

This check box group enables (checked) or disables (unchecked) the display of the 
indicated character attribute. Unitech character-based terminal displays are capable of 
displaying only the Reverse and Blinking attributes. All other attributes, if enabled, are 
displayed in Reverse, except for those attributes checked in the Blink Mask group (see 
below).  

ttribute Mask 

  PowerNet Twin Client Reference    •  May, 2006 6-24



  Advanced 3270 Keyboard Options 

Fi

The VT100 and VT220 protocols do not support the more efficient block mode of 
cols, since there are no VT100 or 

selected attribute(s), all characters to the right of that position with the 
ecify the length of the input field. 

ecked) or disable (unchecked) the conversion 

Advance
iew Keyboard tab is active when the 3270 

ate keystroke 

eld Mask 

operation that is standard in the 3270 and 5250 proto
VT220 protocol commands for defining input fields. 

However, Twin Client makes it possible to simulate block mode operation by using video 
display attributes to define input fields. Each box checked in the Field Mask window 
indicates a video attribute that will be recognized as an input field specification by the 
emulator. During a terminal session with a host, whenever the cursor is positioned on 
character with the 
same attribute are interpreted to sp

Blink Mask 

This check box group is used to enable (ch
of the selected attribute to Blinking. 

d 3270 Keyboard Options 
The Advanced button in the advanced v
emulation is selected. The option groups in this window are used to autom
generation under the special conditions described in the following subsections. It is also 
used determine the action taken with oversized scans. 

 

Attribute Key 
This option is used to automatically transmit a keystroke to the 3270 host when the 3270 
field matches the selected attribute. The automatic keystroke generation can be based on 

ut is scanned, or keyed, or both.  

e Key to a value other than noop and 
 a value other than off) it overrides all 

he Last Field Keys rules 
(described later in this section). 

whether the inp

Note: When this feature is made active (setting th
setting the Scan Field and or Key Field to
other automatic keystroke generation rules except for t
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Key 

This scrolling list box is used to select the 3270 keystroke sent with scanned or keyed 
attribute setting specified in Scan Field and Key 
ides all other automatic keystroke generation, 

unction. 

Scan Field 

This scrolling list box selects the 3270 field attribute that, when data is scanned into the 
 The 

 selects the 3270 field attribute that, when data is keyed into the 
ompletely filled, results in automatic transmission of the selected 

The choices are pen (for 3270 Light Pen Enabled), num 
(for 3270 Numeric Only), hi (for 3270 High Intensity), and hal (for 3270 High Intensity 

eration when the keyed or scanned input is 
ld on the 3270 display. 

errides all other automatic keystroke 
, and Attribute Key). 

elect the 3270 keystroke to be sent when data is scanned 
. The default value is noop, which disables this 

function.  

Keyed Input 

This scrolling list box is used to select the 3270 keystroke to be sent when data is keyed 
into the last field on the 3270 display, and the field is filled. The default value is noop, 
which disables this function. 

Multiple Fields  

This check box enables (checked) the Last Field Keys group only if the host display 
contains more than one input field. 

input when the field matches the selected 
Field (described below). This option overr
except for Last Field processing. The default key setting of noop disables this f

field, results in automatic transmission of the selected Key with the data to the host.
choices are pen (for 3270 Light Pen Enabled), num (for 3270 Numeric Only), hi (for 
3270 High Intensity), and hal (for 3270 High Intensity and Light Pen Enabled). The 
default value is off. 

Key Field  

This scrolling list box
field and the field is c
Key with the data to the host. 

and Light Pen Enabled). The default value is off. 

Last Field Keys 
This option is used to automate keystroke gen
into the last fie

Note: When this rule generates a keystroke, it ov
generation rules (i.e., Scan Key, Auto Send Key

Scanned Input  

This scrolling list box is used to s
into the last field on the 3270 display
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NEW ENVIRON Telnet Extension 
The NEW ENVIRON Telnet extension, also known as Workstation ID, is a mechanism 
fo
th

The N

r providing named variables with values to the host system via a Telnet negotiation at 
e beginning of each terminal session. 

ew Environ option under the Twin Client Manager's Settings menu is used to 
create the variables, which are applied to all terminal configurations. Variables can be 

ble created that apply only to specific terminals (indicated by IP address). It is also possi
to create variables that apply to all terminals. 

 

Creating Common Settings 
erminal sessions are created by clicking on the CVariables that apply to all t ommon to 
en entering the Variable and Value in the respective boxes. all terminals button, and th

Then click on the Set button. 
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The variable and its value are then displayed in the bottom list window.   

Creating Terminal Specific Settings 
Variables that apply to specific terminal sessions are created by clicking on the Terminal 

er 
lue in the respective boxes and click on the S

Specific button, and entering the last two octets of the terminal IP address. Then ent
the Variable and Va et button. 

 

Note: Click on the Show all settings check box to display both terminal specific and 
common variables. 
 

When you set up the IP address in the New Environment entry form, you can get an 
“Invalid terminal address” error message. This error is from a routine that checks the IP 

 notation rather than the 
more common decimal method we see most often.  
address for accuracy. In IP settings, it is possible to use octal
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The rule is that if the
octal value (legal oct

re is a leading zero, it assumes octal notation and checks for a valid 
al values are 0-7). For example, if the second half of your terminal 

IP address is 078.131, the 8 in the .078 is what causes the error. The terminal client needs 

 
that you hand edit the configuration file to 

add the leading zeros if required. 
 

ts, you 

env.cf file for edit. Add leading zeros to entries: 

Save and send this to the terminal by doing a "Terminal/Send Configuration Files to 

 and Deleting Settings 
n be modified or deleted by clicking on the variable in 

the list window. Change the variable or value by editing the V

the leading zero(s) to correctly find the IP address. This leads to a catch 22.  

Note: The following work-around will require 

1. Enter the address as normal without any leading zeros. If they are all 3-digit octe
need do nothing. If any octet is less than 3 digits, do the next step. 

 
2. Open the PowerNet\TwinClient\tn

 
78.132:DEVNAME=RF001;!    →    078.132:DEVNAME=RF001;! 
1.133:DEVNAME=RF002;!      →    001.133:DEVNAME=RF002;! 
12.134:DEVNAME=RF003;!    →    012.134:DEVNAME=RF003;! 

Terminal" operation. 

Changing
Variable names and their values ca

ariable and/or Value 
boxes, and click on the Set button. To delete the variable, press the Delete key on t
PC. Deleted variables will continue to appear in the pull down list until after the settin
have been saved. 

he 
gs 

Saving New Environ 
n the OK button to save the New Environ settings. 

 Lunames  the Telnet terminal to the 

he tnenvcom.cf file allows for the definition 
of variables that will be shared by all devices, and the tnenv.cf file allows for the 
definition of terminal-specific variables. These files are currently created and maintained 

.cf: 

VARIABLE=VALUE; 

Example *DEVTYP=IBM-3278-2;*CONNECT=RFZ81; 

Click o

TN3270E Negotiation 
The following defines the TN3270E negotiation, permitting the transfer of some of the 
TN3270E Sub-negotiation variables such as from
host during session initialization. 

Note: This pertains to 3270 emulation. 

TN3270E is implemented on OpenAir Linux using two text files located in the working 
directory (refer to /etc/.CRF/WORKDIR). T

with the system editor. 
 
Line Entry Format, tnenvcom
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This will assign all terminals the luname of RFZ81. 
 
Line Entry format, tnenv.cf: 

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…! 

Where IDENT is either the last two octets of the terminal's IP address, or the three digit 
Spectrum address (065-511). Multiple variables can be defined, separated by semicolons. 
The entry is terminated with an exclamation. 

Example file: 

#IP terminals fully qualified octets 7 characters: 

.001;! 

010.032:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.002;! 

The following defines the New Environ negotiation, permitting the transfer of 
environmental variables from the Telnet terminal to the host during session initialization. 

Note: This pertains to the 5250 and VT emulations. 

New Environ is implemented on OpenAir Linux using two text files located in the 
working directory (refer to /etc/.CRF/WORKDIR). The tnenvcom.cf file allows for the 
definition of variables that will be shared by all devices, and the tnenv.cf file allows for 
the definition of terminal-specific variables. These files are currently created and 
maintained with the system editor. 

Line Entry Format, tnenvcom.cf: 

VARIABLE=VALUE; 

Line Entry format, tnenv.cf: 

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…! 

Where IDENT is either the last two octets of the terminal's IP address, or the three digit 
Spectrum address (065-511). Multiple variables can be defined, separated by semicolons. 
The entry is terminated with an exclamation. 

Example file: 

acters: 

010.031:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278

This will assign the terminal with an IP address of xxx.yyy.010.031 a device type of IBM-
3278-2 to the luname of RF3278.001. 

New Environ Negotiation 

#IP terminals fully qualified octets 7 char

010.031:DEVNAME=RF5291.001;! 

#Spectrum ONE fully qualified radio ID 3 characters 

065:DEVNAME=RF5291.002;! 
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Chapter 7 • The Display Formatter 
The display formatter adapts full screen Telnet applications to the portable terminal 

e 

A screen capture utility (included with the Twin Client Manager) is used to access the 
host application via Telnet and "capture" the host displays. Once captured, the screens are 
processed into a screen formatter object and assigned to a terminal configuration, which 
can then be downloaded automatically to the terminal, over the wireless network. 

The Twin Client Display Formatter provides the following unique features: 
• Performance - Optimized for minimum run-time overhead and maximum speed. 
• Transparency - Fully transparent to the host application. 
• Capacity - Up to 128 host screens per object, 16 terminal screens per host screen, 

and 32 input fields per terminal screen. 
• Simplicity - Intuitive drag-and-drop interface for screen capture and formatting. 
• Flexibility - Supports all Twin Client terminals. 

This chapter describes how to set the emulation, capture the host application displays, 
and process them into formatter objects for download to the terminal. 

Setting the Emulation 

environment without any modification to the host application. This powerful tool is 
included with PowerNet Twin Client, and is also used with the OpenAir server when th
Twin Client is operating the server-based "thin" mode. 

The first step in the formatting process is to set the emulation (VT, 3270, or 5250) in 
preparation for capturing the host application displays. Click on Start, Programs, 
PowerNet, and Twin Client Manager, and then the Settings menu, as shown below. 

 

Click on Emulation and select an emulator from the list below. 
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Then click on OK to return to the main PowerNet Twin Client menu. 

Starting the Emulator 
Start the emulator by clicking on the Object Editors menu and Screen Capture, as 
shown below. 

 

The emulation window is displayed. Click on the Session menu, and then click on
S

 
ession Settings. 

 

In the Session Settings menu, enter the Host IP address and port of the host system, and 
then Click on OK to return to the emulator main menu. 
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Note: The Host Port of 23 is standard for Telnet. However, for security reasons, the port 
number may be set to other values. Consult the local network administrator if a 
connection cannot be established on port 23. 

 

To start a Telnet session with the host, click on the  toolbar icon, or click on the 
Session menu and then on Connect. In this example, the 5250 emulator is used and the 
host system is an IBM AS/400. 

 
The host application displays are now ready to be captured. 
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Taking Snapshots 
The host screens are captured by clicking on the  toolbar icon while the desired 
screen is displayed. Alternately, click on Session and then Snapshot. The following 
pop-up indicates that the screen was captured. 

 

Click on OK and continue to navigate the host application, taking snapshots of the 
screens to be formatted. 

Saving the Screen File 

Save the snapshots at any time by clicking on the  toolbar icon. Alternately, click on 
File and then Save As. The following window is displayed for entering the filename. 

 

For this example, the filename is set to app1. Then click on the Save button to return to 
the emulator.  

Exiting the Emulator 

The Telnet session is ended by clicking on the  toolbar icon, or by clicking on 
Session and Disconnect. Return to the Twin Client Manager window to format the 
screens by clicking on the  icon at the top right corner of the emulator, or by clicking 
on File and Exit. 
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Formatting 
The screen file created in the previous sections can now be formatted. This section 
de
fo

Starting the Formatter 

scribes how to start the formatter, open a screen file, format the screens, save the 
rmatted object, and finally to assign it to a configuration. 

The formatter is started from the Twin Client Manager menu. Start the Twin Client 
Manager by clicking on Start, Programs, PowerNet, and Twin Client Manager. Then 
click on Object Editors, as shown below. 

 

Click on the Display/Formatting option and the formatter window is displayed. To open 
the screen file, click on File. 

 

Then click on Open, and click on the screen filename. 
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Then click on the Open button and the formatter window is displayed, including the first
host display that was captured. The terminal display

 
 window, which is blank at this time 

since no formatting has taken place, is also shown. 

e host screen. If it needs to be 
n. 

Note: The Terminal display window floats on top of th
moved, click on the title bar and drag it to a different area of the host scree

 

Setting Up the Formatter 
The terminal display must be set to match the terminal for which the formatter object is to 
be created. Click on the Tools menu and then Setup.  

 
the selected screen size causing the reformatted screen not to appear on the 

screen in question and reformat it, paying attention to 
creen. 

Note: If, while reformatting host screens, you are able to create display fields larger than 

terminal; Delete the terminal 
the width of the RF terminal s
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Click on the desired terminal display size, and also ensure that the host screen size is set 
correctly. Then click on OK to return to the formatter. 

Adding Idents 
ely identified. One way to do this is to 

highlight unique text on the host screen. (Click on the left side of the text and drag the 
mouse to the right.) Then click on the right mouse button, as shown below. 

Formatting requires that each host screen be uniqu
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From the pull down menu, click on Add Ident. The highlighted field is now colored red 
on the host display, indicating that it is an Ident field. Up to 32 items can be highlighted 

 
 by 

ng Display Text 
moving 
gn On 

It is also useful to copy variable text from the host display to the terminal display. To do 
in the host display and hold down the mouse 

button while m
e highlighted text to the desired 
on. 

on each host screen, so if a number of screens share similar features, they can be uniquely
identified by adding more Idents. In the event that a group of host displays differ only
position of input fields, input fields can be used for Idents also. 

Adding and Copyi
Text can be added to the terminal display by clicking on the Terminal window, 
the cursor to the desired display position, and typing in the text (in this case, Si
Screen) as shown below. 

this, move the cursor to the desired position 
oving the cursor to the right. The text to be copied will be highlighted as 

shown by the POWERNET text copied below. Then drag th
position in the terminal display and release the mouse butt

 

Copying Input Fields 
Input fields are copied from the host di
used to copy text. Click on the left side

splay to the terminal display by the same method 
 of the input field and drag the cursor to the right. 

 desired 

Adding Terminal Screens 

ore that one terminal screen is required to format 
the relevant data on the host screen. Up to 16 terminal displays can be associated with 
each formatted host display. These are called terminal pages, and the page that is 
displayed on the terminal at any point in time depends on the location of the host cursor 
position. The page to which the corresponding input field is formatted is the one 
displayed. 

The input field will be highlighted. Now click on the field again and drag it to the
position in the Terminal display. 

New terminal screens are created by using the New button at the bottom of the Terminal 
display window. This is useful when m
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When multiple pages are present, the directional arrows are used to navigate through the 

Savi

The formatter object is saved by clicking on the 

pages. 

ng the Formatter Object 

 toolbar icon, or by clicking on File 
and Save.  

Assigning the Object to a Terminal Configuration 
The formatter object is assigned to a terminal configuration by opening a terminal 
configuration in the Twin Client Manager, assigning the object to the Display Formatting 
Object, and saving the configuration.  

o open a terminal configuration, click on  in the Twin Client Manager, as shown T File
below. 

 

Then click on Open, and click on the desired terminal configuration. 

 

T
scrolling list box, and click on the object. 

hen click on the advanced view Display tab, pull down the Display Formatter Object 

PowerNet Twin Client Reference   •   May, 2006    7-9



The Display Formatter 

 

Save the newly modified terminal configuration using the  toolbar icon, or click on 
File and then Save. The new configuration, incorporating the formatter object, is updated 
on the terminal, automatically, by booting the terminal. 
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Chapter 8 • Software Management 
In addition to providing functions for the download of files to the terminal via the 
traditional serial connection, the Twin Client Manager also provides for the managemen

itional manual operations 
involving serial download options are described at the end of this chapter. 

Airloade
The software and supporting configuration files for all Twin Client terminals can be 
configured for automated management. The Airloader Auto-Configuration form is 
accessed from the Twin Client Manager To

t 
of terminal software and configurations automatically over the wireless network. 

This chapter describes the automated capability in detail. Add

r Auto-Configuration 

ols menu. Select Airloader. 

 
Note: If no options are displayed, click on the Advanced<< button. 

Enabling Automatic Downloads 
Click to put a check in the Allow terminals to be automatically configured via RF box 
to enable automatic downloading. In the event that another PC on the network is already 
configured and active, the following warning message is displayed. 
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Synchronizing Configuration Files 
Click to put a check in the Synchronize Configuration Files box to enable automatic 
synchronization of configuration files on the terminal. When the terminal is booted, its 
configuration files will be compared with the most recent on the PC. The terminal is 
updated automatically if it does not have the latest revision. 

Synchronizing Program Files 
Click to put a check in the Synchronize Program Files box to enable automatic 
synchronization of program files on the term inal is booted, its 

n the PC. The terminal is updated 

Automatic IP Address Assignment 
e following box is 

checked. 

inal. When the term
program files will be compared with the most recent o
automatically if it does not have the latest revision. 

New terminals will be assigned IP addresses automatically if th

 
Note: Do not check this option if a DHCP server is configured to manage address 

To set the addresses, click on the Addresses button to access the Segment Address 

assignments. 

Assignments dialog box, as shown in the following figure. 
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Enter the desired range in the From and To boxes as shown above, and then click on 
Add. 

ew groups, with different configurations, can be created by clicking on 

Creating New Groups 
N
Terminal/Group Manager, and then clicking the right mouse button as shown below. 

 

After the new group has been created, the group settings option becomes available for 
change, as shown below. 
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Af er the Configuration File 
ma e active by clicking on th

t and all of the other parameters have been set, the group is 
d e Active check box. 
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Clicking on the Thin Mode button will cause all terminals in this group that are 
currently running in thick mode to be switched to thin mode the next time Airloader 
is run on the terminal. 

Click on the Schedule button to view a dialog box for scheduling an automatic Airloader 
update. 

 

Select the desired time and click on OK. Click on Update Now and the Airloader “push” 
ls from this end. capability controls termina

PowerNet Twin Client Reference   •   May, 2006    8-5



Software Management 

Setting the Segment 

Checking the Segment button restricts a terminal group to a range of IP addresses. The 
IP Address can be any valid address on the segment, as it is used only to identify the 
segment. The setting of the Net Mask can be used to restrict the range. This feature is 
useful for segregating terminal groups by location. 

Setting Force Reload 

Clicking on the Force Reload button forces all terminals within a group to be 
ated. The following warning message appears. automatically upd

 

Click on the Yes button to force the reload. 

Setting the Default Terminal Group 
New terminals that have not yet been assigned to any group are initially assigned to the 
default group in effect when they are booted. 

 

Any group can be made the default group by clicking on the group, and then clicking on 
the right mouse button. Then click on the Make Default option. 

Reassigning Terminals 
After a terminal has been configured and assigned to the default group, it can be 
reassigned to a new group by clicking on the terminal icon as shown below. 
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  Mobile Device Manager (MDM) Features 

Then, holding the mouse button down, drag the terminal icon to the desired group as 
shown next. 

 

Release the mouse button, which reassigns the terminal. 

 

The next time the terminal is rebooted, it will be reconfigured as defined in the group 
specification. 

Mobile Device Manager (MDM) Features 
 

nder Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, U
and RF Monitor features. 

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 
Messenger features depending on its Authorization codes. 

 
 
Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
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A screen will appear with a display resembling the terminal screen. 
 

 

Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 
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  Mobile Device Manager (MDM) Features 

 
Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 

essenger screen below. See the example of the Terminal M

 
 
To remove a terminal from the list of terminals vin ur message, click on the 

 Select Terminal(s) column, and click on the R
 recei g yo

terminal number in the emove button. 
te button, Remo lClick on the appropria ve A l, Select A Ull, or nselect All, to remove all 

 all terminals, or unselect all term  the Select Terminal(s) list. 

e Ctrl and Shift keys to select multiple term

terminals, select inals from

Note: Use th
 

inals. 

Click on the Close button when finished. 

Select RF Monitor from the Tools menu. 
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agn ic tool. It is used to collect diagnostic trace 
 RF terminals running PowerNet Twin Client software. 

 
ll send omm o t F terminal to start tracing. 

n it receives this command, will start sending the trace information 
 the PC that issued t comm  Th ill be written to a file on this 

 for analysis. 
 

RF Monitor is an "Over The Air" di ost
information from

It runs on a Windows PC and wi  a c and t he R
The terminal, whe
over the RF link to he and. is w
PC that can be sent to us

Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows y
Terminal IP address and Ter

ou to view a log of the terminal’s activity. Enter the 
minal IP Port, and click on OK.  
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  Mobile Device Manager (MDM) Features 

 
 
Click on Edit. Select Find and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 

 

Click on Actions to select Start Monit r Stor o op Monitor. 

 

Click on Tools to choose Set Debug Levels or Settings. 

 

 
The options in Set Debug Levels are shown below. 
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an be set u er Set . The maximum log file size c nd tings

 
 

Click on View to show or hide the Toolbar and the Status Bar. 

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on About RF Monitor under Help to view version number information. Click on  
About Twin Client Manager under Help in the main menu to view the following screen. 
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  Mobile Device Manager (MDM) Features 

 
 

RF nitor a ve mall ogra and  no en r ire i llatio us ce it
a directory on you  and eate hort o ru t. It l run all ver on
W s e pt V  and ndo  95.
 
1. ve on  to a indo  PC  Ne rk ss t  RF t in
 
2. n R oni Crea a sh cut o  a t/R  
 
3. m the pull down me , se  File lect rmi
 
4.  in the RF terminal IP address and leave the port at 1802. 

 

 Mo  is ry s pr m does t ev equ nsta n. J t pla  in 
r PC  cr  a s cut t n i wil  on si s of 

indow xce 3.1 Wi ws   

Mo RF M itor W ws  with two acce o the erm al. 

Ru F M tor. ( te ort r do Star un.)

Fro nu lect /Se  Te nal. 

Key

 
 

5 m the pull down me , se  Tools/Set Debug Levels  all le ls t xce
tast  and SNA. 

 

. Fro nu lect . Set ve o 9 e pt 
Da ream
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6. th F te inal sitting at the ey pt, select Actions/Start 

 
7. ss  on the RF termin  o  sess , a

 M r win ow en d , e e tra and file will be named 
xx log ( her .yy  th  2 oc s o RF terminal’s IP address) in 

 in which RF Monitor was running. 
 

 
Wi the R

. 
rm Press Any K  prom

Monitor

Pre  a key al to pen a ion nd you should see trace data in the 
RF onito d . Wh one nd th ce  the 
tnx .yyy. w e xxx y is e last tet f the 
the directory
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  Mobile Device Manager (MDM) Features 

 

Common Problems with RF Monitor 
 

inal can miss the command to start the 
trace. Below are some things that can be useful. 
 
a.   Ping the RF terminal from the PC used before starting RF Monitor. (This seems 

to "open" a path to the terminal.) 

b.   Start the Monitor with the terminal at the Press Any Key prompt. (While the 
terminal is at this prompt, it is not doing much and has a better chance of hearing 
the start trace command.) 

 
I don't understand what this trace means. 

 
The trace that this tool collects is engineering-level information. It allows an end user 
to collect information that can be analyzed by Connect engineering. 
 
It will generally be requested by Connect support to help diagnose a reported 
problem. 
 
To be able to read and understand these completely, you need to have an 
understanding of: 

 

• The trace won’t start.  

RF Monitor uses UDP to send commands to the RF device. On busy networks, UDP 
packets are not always delivered. The term

• 
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a.  Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.) 
b.  PowerNet Twin Client products 
c.  RF Network concepts 
d.  Wired network concepts 
e.  Telnet sessions 
f.   TCP/IP  

 

They are text files that can be read with any editor or viewer and can be useful to end 
users and integrators, even if they may not have all the requirements above. 
 

• I have an intermittent problem and it could happen on any one of my 100 
terminals. RF Monitor only does one terminal at a time. What can I do? 

RF Monitor is not the right diagnostic tool for this type of problem. PowerNet 
products have another diagnostic tool that can be used called the "Diagnostic Server".  
 
This tool can be set up to run trace diagnostics on up to 300 terminals at the same 
time. This tool will be provided as needed for systems under PowerNet support 
agreement OR by T&M when they are not covered. 

It also includes the service of a PowerNet support engineer. 

 
Server Transfer is another feature. From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 

 
x 
To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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  Sending Program and Configuration Files to the Terminal 

Sending Program and Configuration Files to the 
Terminal 

 

1.   Boot the terminal.     

2.   On the PC, select Send Program Files to Terminal from the Terminal menu in Twin 
Client Manager. 

 

The following screen will appear. 

 

3.   Click on OK. 

The following screen will appear. 

 
 

 
4.   Click on OK. 
 
5.   On the PC, choose Send Configuration Files to Terminal from the Terminal menu 

in Twin Client Manager. 
 

 
 

You will see the following screen. 
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6.   Choose Yes. 
 

 
 

7.   Click on OK. 
 

The following screen will appear. 
 

 
 
 

8.       Click on OK. 
9.     On the terminal, click on Start, Programs, File Explorer, and Windows. 
10.   Select the Aironet Client Utility icon. 
11.   Enter the SSID, etc. 
12.   Click on OK. 
13.   Click on Start, Settings, and Control Panel.  
14.   Select the Network icon and choose on the Properties tab.  
15.   Set the IP Address, Subnet Mask, and Default Gateway, and click on OK. 
16.   Click on Start, Programs, TwinClient, and AirloaderSetup. 
17.   Make sure that the Run AirLoad checkbox is checked or unchecked, as desired. 
18. Click on OK. 
19. Warm boot the terminal. 
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  Sending Program and Configuration Files to the Terminal 

Under Terminal, you may select Receive File from Terminal. 
 

 
 
Enter the path and file name to receive from the terminal in the Upload File dialog box. 
 

 
 

The default file is “rf.log”. Click on OK. 
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Chapter 9 • Character Sets 

ISO 8859-1 Character Set 
 

Description Char Dec Hex 

non-breaking space  160 A0 

inverted exclamation ¡ 161 A1 

cent sign ¢ 162 A2 

pound sterling £ 163 A3 

general currency sign ¤ 164 A4 

yen sign ¥ 165 A5 

broken vertical bar ¦ 166 A6 

section sign § 167 A7 

umlaut (dieresis) ¨ 168 A8 

copyright © 169 A9 

feminine ordinal ª 170 AA 

left angle quote, guillemot left « 171 AB 

not sign ¬ 172 AC 

soft hyphen - 173 AD 

registered trademark ® 174 AE 

macron accent ¯ 175 AF 

degree sign ° 176 B0 

plus or minus ± 177 B1 

superscript two ² 178 B2 

superscript three ³ 179 B3 

acute accent ´ 180 B4 

microsign µ 181 B5 
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Description Char Dec Hex 

paragraph sign ¶ 182 B6 

middle dot · 183 B7 

cedilla ¸ 184 B8 

superscript one ¹ 185 B9 

masculine ordinal º 186 BA 

right angle quote, guillemot right » 187 BB 

fraction one-fourth ¼ 188 BC 

fraction one-half ½ 189 BD 

fraction three-fourths ¾ 190 BE 

inverted question mark ¿ 191 BF 

capital A, grave accent À 192 C0 

capital A, acute accent Á 193 C1 

capital A, circumflex accent Â 194 C2 

capital A, tilde Ã 195 C3 

capital A, dieresis or umlaut mark Ä 196 C4  

capital A, ring Å 197 C5 

capital AE diphthong (ligature) Æ 198 C6 

capital C, cedilla Ç 199 C7 

capital E, grave accent È 200 C8 

capital E, acute accent É 201 C9 

capital E, circumflex accent Ê 202 CA 

capital E, dieresis or umlaut mark Ë 203 CB 

capital I, grave accent Ì 204 CC 

capital I, acute accent Í 205 CD 

capital I, circumflex accent Î 206 CE 

capital I, dieresis or umlaut mark Ï 207 CF 

capital Eth, Icelandic Ð 208 D0 

capital N, tilde Ñ 209 D1 

capital O, grave accent Ò 210 D2 

  PowerNet Twin Client Reference    •  May, 2006 9-2
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Description Char Dec Hex 

capital O, acute accent Ó 211 D3 

capital O, circumflex accent Ô 212 D4 

capital O, tilde Õ 213 D5 

capital O, dieresis or umlaut mark Ö 214 D6 

multiply sign × 215 D7 

capital O, slash Ø 216 D8 

capital U, grave accent Ù 217 D9 

capital U, acute accent Ú 218 DA 

capital U, circumflex accent Û 219 DB 

capital U, dieresis or umlaut mark Ü 220 DC 

capital Y, acute accent Ý 221 DD 

capital THORN, Icelandic Þ 222 DE 

small sharp s, German (sz ligature) ß 223 DF 

small A, grave accent à 224 E0 

small A, acute accent á 225 E1 

small A, circumflex accent â 226 E2 

small A, tilde ã 227 E3 

small A, dieresis or umlaut mark ä 228 E4 

small A, ring å 229 E5 

small AE diphthong (ligature) æ 230 E6 

small C, cedilla ç 231 E7 

small E, grave accent è 232 E8 

small E, acute accent é 233 E9 

small E, circumflex accent ê 234 EA 

small E, dieresis or umlaut mark ë 235 EB 

small I, grave accent ì 236 EC 

small I, acute accent í 237 ED 

small I, circumflex accent î 238 EE 

small I, dieresis or umlaut mark ï 239 EF 
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Description Char Dec Hex 

small Eth, Icelandic ð 240 F0 

small N, tilde ñ 241 F1 

small O, grave accent ò 242 F2 

small O, acute accent ó 243 F3 

small O, circumflex accent ô 244 F4 

small O, tilde õ 245 F5 

small O, dieresis or umlaut mark ö 246 F6 

division sign ÷ 247 F7 

small O, slash ø 248 F8 

small U, grave accent ù 249 F9 

small U, acute accent ú 250 FA 

small U, circumflex accent û 251 FB 

small U, dieresis or umlaut mark ü 252 FC 

small Y, acute accent ý 253 FD 

small THORN, Icelandic þ 254 FE 

small Y, dieresis or umlaut mark ÿ 255 FF 
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ASCII Character Set 
Decimal and Hexadecimal Values 
 

ex  Dec Hex  Dec Hex  Dec Hex  Dec H
NUL 0 00 SP 32 20 @ 64 40 ` 96 60 
SOH 1 01 ! 33 21 A 65 41 a 97 61 
STX 2 02 " 34 22 B 66 42 b 98 62 
ETX 3 03 # 35 23 C 67 43 c 99 63 
EOT 4 04 $ 24 D 44 d 64 36 68 100
ENQ 5 05 % 25 E 45 e 65 37 69 101
ACK 6 06 & 26 F 46 f 66 38 70 102
BEL 7 07 ´ 27 G 47 g 67 39 71 103

BS 8 08 ( 28 H 48 h 68 40 72 104
HT 9 09 ) 29 I 49 i 69 41 73 105
NL 10 0A * 2A J 4A j 6A 42 74 106
VT 11 0B + 2B K 4B k 6B 43 75 107
NP 12 0C , 2C L 4C l 6C 44 76 108
CR 13 0D - 2D M 4D m 6D 45 77 109
SO 14 0E . 2E N 4E n 6E 46 78 110
SI 15 0F / 2F O 4F o 6F 47 79 111

DLE 16 10 0 30 P 50 p 70 48 80 112
DC1 17 11 1 31 Q 51 q 71 49 81 113
DC2 18 12 2 32 R 52 r 72 50 82 114
DC3 19 13 3 33 S 53 s 73 51 83 115
DC4 20 14 4 34 T 54 t 74 52 84 116

NAK 21 15 5 35 U 55 u 75 54 85 117
SYN 22 16 6 36 V 56 v 76 54 86 118
ETB 23 17 7 37 W 57 w 77 55 87 119
CAN 24 18 8 38 X 58 x 78 56 88 120

EM 25 19 9 39 Y 59 y 79 57 89 121
SUB 26 1A : 3A Z 5A z 7A 58 90 122
ESC 27 1B ; 3B [ 5B { 7B 59 91 123

FS 28 1C < 3C \ 5C | 7C 60 92 124
GS 29 1D = 3D ] 5D } 7D 61 93 125
RS 30 1E > 3E ^ 5E ~ 7E 62 94 126
US 31 1F ? 3F _ 5F DEL 7F 63 95 127
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ASCII Character Set 
Octal Values 
 

 Oct  Oct   Oct Oct
NUL 000 SP 040 100 `  @ 140
SOH 001 ! 041 101 a  A 141
STX 002 " 042 102 b  B 142
ETX 003 # 043 103 cC 143 
EOT 004 $ 044 104 dD 144 
ENQ 005 % 045 105 eE 145 
ACK 006 & 046 106 fF 146 
BEL 007 ´ 047 107 gG 147 

BS 010 ( 050 110 hH 150 
HT 011 ) 051 111 iI 151 
NL 012 * 052 112 jJ 152 
VT 013 + 053 113 kK 153 
NP 014 , 054 114 lL 154 
CR 015 - 055 115 mM 155 
SO 016 . 056 116 nN 156 
SI 017 / 057 117 oO 157 

DLE 020 0 060 120 pP 160 
DC1 021 1 061 121 qQ 161 
DC2 022 2 062 122 rR 162 
DC3 023 3 063 123 sS 163 
DC4 024 4 064 124 tT 164 

NAK 025 5 065 125 uU 165 
SYN 026 6 066 126 vV 166 
ETB 027 7 067 127 wW 167 
CAN 030 8 070 130 xX 170 

EM 031 9 071 131 yY 171 
SUB 032 : 072 132 zZ 172 
ESC 033 ; 073 133 {[ 173 

FS 034 < 074 134 |\ 174 
GS 035 = 075 135 }] 175 
RS 036 > 07 136 ~6 ^ 176 
US 037 ? 077 137 DEL _ 177 
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Chapter 10 ypad Configuration  • Ke
This chapter describes the Pow t key assignments applied to Unitech term  used 

t advanced mode. The figures and tables identify the key assignm s by 
nd emulation.  

als that reflect the figurations described in this chapter are available for 
rminals in each of the emulations (3270, 5250, and VT). 

Keypad Figures 
 keypad figures in this section are designed to be of e without color. Th

ntion for describing the ef t of modifier keys

OP refers to the characters printed on the top of the key by the manufacturer. In 
ample, the FUNC key odifier. 

e example figure above, t stroke generated in the un-modified state is an 0. The 
ammable function key backlight is generated by ssing the FUNC r key 

ressing the 0 key, illustrated below.  

 

 

 

erNe inals
in Twin Clien ent
terminal model a

Adhesive dec  con
Unitech te

The  us e 
conve fec  is as follows: 

 

   

KEYT
this ex is the m

In th he key
progr  pre modifie
before p

 

 

 

   keytop 
func

       0 
backlight 

To select the Twin Client Keyboard, follow these instructions. 
 

1. Click on Start, Settings, and Control Panel. 
2. Select the Input Panel. 
3. Choose TwinClient kbd from the drop down menu. 
4. Choose OK. 
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CTL ↑ ↓ ← → \ ` 

bc nx z ← mv Shift .,

← 

/ 

i o pq w ye 

1 098653 2 =- 74 Esc 

 ur tb [ ] Ta

a jd ks gAP ‘l f hC ; 

 

au ̈ ´ 

Lo  Character Stan yboard Mode 

 

wercase dard Ke

F1          F2           F3          F4         F5           F6           F7         F8          F9          F10

        Standard                                              Function                                                   Special 

  PowerNet Twin Client Reference    •  May, 2006 10-2



  Keypad Figures 

F1          F2           F3          F4 5           F6           F8              F          F7   F9          F10  

Esc ! @ # $ % ^ & ( )* +_ Del 

CTL ↑ ↓ ← → au ̈ ´ | ~

P Q W E UR Y OTab }IT
 
{ 

← VC N MX Z Shift >

A HD J

 B ? <

K L S GCAP “

Upperca cter Standard  Mode

F :

se Chara  Keyboard

  Standard                                 Function                                                 S                   pecial 
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Lowercase International Symbol Keyboard Mode

↑ ← ↓ → 

ò ó ô õ ö ù ú û ü

ý ÿ 

/ 

à á â ã ä å ç [ ] ðæ ñ 

←= ¿ ¡ µ±£ §¥ ◦œ ¢ 

au ̈ ´ 

 

← 

ì í ï è é ê ‘ Þ  ë šî 

-

CTL 

Esc 

 
CAP

Tab 

Shift 

F1          F2           F3             F5           F6       F8        F10    F4               F7          F9       

        Standard                                              Function                                       Special 
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Uppercase International Symbol Keyboard Mode

“ 

¿ µ±

au ̈ ´ 

 

←

¡ 

 

Del 

} { 

Ý Ÿ

? 

Š þ

Ñ ÐÇÆ

Œ +°

À Á Â Ã Ä Å

- 

È É Ê Ë Ì Í Î Ï

Ò Ó Ô Õ Ö Ù Ú Û Ü

↑ ↓ ← →

§¥¢ £

CTL 

Esc 

CAP 

Tab 

Shift 

F1          F2         F4          F5           F6           F7         F8          F9          F10

        Standard                                           

      F3      

   Function                                       Special 
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func 
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  6 

 

  9 

 

  3 

 

  4 

 

  7 

   
   tab  

 
 
 
bksp 

   up 
 
 

 
 
 
 en  

 1 

 
 down  

ter

Numeric Keyboard 

keypad 

func 

darken 

bklite 

lighten 
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Keypad Figures 

erNet Twin Client Reference  •   May, 2006  10-7

Function Keys

P

PF18 PF17 

3

PF20 

F10 PF11 PF12 PF1 PF1
4

PF16PF15

PF7

PF19 

PF3 PF8

PF24PF2

PF1 PF4 

PF9 

PF2 PF5 PF6

2
PF23PF2

1

    Standard                         Function                        Special
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Home Bottom 

PA1 

Insert Top 

PA2 special PA3 

VT100 

Standa unctird    F on      



  

Pow

Keypad Figures 
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3270 

PA1 

SysF ome eset 

special

C

PA3 PA2 

reqEEOH R lear 

    Standard         Function          Special

  



Keypad Configuration 

 10-10  PowerNet Twin Client Reference    •  May, 2006 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5250 

 Attn 

Print Rolldn 

Reset EEOF 

p sp l 

Ins

        Standard            Func
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Sysreq 

Home 

Help 

Del 

Fexit 

Du

Clear
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eciaFM

ert 
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Pow

 Unitech Terminal Keypad Tables 
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Unitech Terminal Keypad Tables 
The keyp tables this se on  organ d by minal m pad configuration, 
and emulation. The key values represent the default keypad assignments applied to the 
terminal in Twin Client advanced mode. 

Table entries that are blank indicate the key is not assigned, or not relevant to the 
emulation. 

3270 5250 

ad  in cti are ize  ter odel, key

 
Key VT 
a <a> <a> <a> 
b <b> <b> <b> 
c <c> <c> <c> 
d <d> <d> <d> 
e <e> <e> <e> 
f <f> <f> <f> 
g <g> <g> <g> 
h <h> <h> <h> 
i <i> <i> <i> 
j <j> <j> <j> 
k <k> <k> <k> 
l <l> <l> <l> 
m <m> <m> <m> 
n <n> <n> <n> 
o <o> <o> <o> 
p <p> <p> <p> 
q <q> <q> <q> 
r < <r> <r> r> 
s < s> <s> s> <  
t <t> <t> <t> 
u <u> <u> <u> 
v <v> <v> <v> 
w < > w> <w> <w
x > <x> <x> <x
y >  <y> <y> <y
z <z> <z> <z> 
A <Shift><a> <Shift><a> <Shift><a> 
B <Shift><b> <Shift><b> <Shift><b> 
C <Shift><c> <Shift><c> <Shift><c> 
D <Shift><d> <Shift><d> <Shift><d> 
E <Shift><e> <Shift><e> <Shift><e> 
F <Shift><f> <Shift><f> <Shift><f> 
G <Shift><g> <Shift><g> <Shift><g> 
H hift><h> <Shift><h> <Shift><h> <S
 I hift><i> hift>< <Shift><i> <S <S i> 
J <Shift><j> <Shift><j> <Shift><j> 
K <Shift><k> <Shift><k> <Shift><k> 
L <Shift><l> <Shift><l> <Shift><l> 
M <Shift><m> <Shift><m> <Shift><m> 
N <Shift><n> <Shift><n> <Shift><n> 
O <Shift><o> <Shift><o> <Shift><o> 
P <Shift><p> <Shift><p> <Shift><p> 
Q <Shift><q> <Shift><q> <Shift><q> 
R <Shift><r> <Shift><r> <Shift><r> 
S <Shift><s> <Shift><s> <Shift><s> 
T <Shift><t> <Shift><t> <Shift><t> 
U <Shift><u> <Shift><u> <Shift><u> 
V <Shift><v> <Shift><v> <Shift><v> 
W <Shift><w> <Shift><w> <Shift><w> 
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X <Shift><x> <Shift><x> <Shift><x> 
Y <Shift><y> <Shift><y> <Shift><y> 
Z <Shift><z> <Shift><z> <Shift><z> 
1 <1> <1> <1> 
2 <2>  <2> <2>
3 <3> <3> <3> 
4 <4> <4> <4> 
5 <5> <5> <5> 
6 <6> <6> <6> 
7 <7> <7> <7> 
8 <8> <8> <8> 
9 <9> <9> <9> 
0 <0> <0> <0> 
!     exclamation <Shift><1> <Shift><1> <Shift><1> 
@   at sign <Shift><2> <Shift><2> <Shift><2> 
#    pound <Shift><3> <Shift><3> <Shift><3> 
$    dollar <Shift><4> <Shift><4> <Shift><4> 
%   percent <Shift><5> <Shift><5> <Shift><5> 
^    carat <Shift><6> <Shift><6> <Shift><6> 
&   ampersand <Shift><7> <Shift><7> <Shift><7> 
*    asterisk <Shift><8> <Shift><8> <Shift><8> 
(    left parenthesis <Shift><9> <Shift><9> <Shift><9> 
)    right parenthesis <Shift><0> <Shift><0> <Shift><0> 
F1 <F1> <F1> <F1> 
F2 <F2> <F2> <F2> 
F3 <F3> <F3> <F3> 
F4 <F4> <F4> <F4> 
F5 <F5> <F5> <F5> 
F6 <F6> <F6> <F6> 
F7 <F7> <F7> <F7> 
F <F8> 8 <F8> <F8> 
F9 <F9> <F9> <F9> 
F10 <F10> <F10> <F10> 
F11 <F11> <F11> <F11> 
F12 <F12> <F12> <F12> 
F13 <F13> <F13> <F13> 
F14 <F14> <F14> <F14> 
F15 <F15> <F15> <F15> 
F16 <F16> <F16> <F16> 
F17 <F17> <F17> <F17> 
F18 <F18> <F18> <F18> 
F19 <F19> <F19> <F19> 
F20 <F20> <F20> <F20> 
F <F21> 21 <F21> <F21> 
F22 <F22> <F22> <F22> 
F23 <F23> <F23> <F23> 
F <F24> 24 <F24> <F24> 
Bksp <Bksp> <Bksp> <Bksp> 
Del <Del> <Del> <Del> 
Tab <Tab> <Tab> <Tab> 
Space <Space> <Space> <Space> 
Enter <Enter> <Enter> <Enter> 
Up <Up> <Up> <Up> 
Down <Down> <Down> <Down> 
Left <Left> <Left> <Left> 
Right <Right> <Right> <Right> 
D n arke <Func><Up> <Func><Up> <Func><Up> 
Lighten <Func><Dow n> n> <Func><Dow <Func><Down> 
Backlight <Func><0> <Func><0> <Func><0> 
View up <Shift><UP> <Shift><Up> <Shift><Up> 
View n <Shift><Dow n>  dow n> <Shift><Dow <Shift><Down> 
View left <Shift><Left> <Shift><Left> <Shift><Left> 
View <Shift><Right> <Shift><Right>  right <Shift><Right> 
{   left brace <Shift><[> <Shift><[> <Shift><[> 
}   right brace <Shift><]> <Shift><]> <Shift><]> 
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|   broken vertical bar <Shift><\> <Shift><\> <Shift><\> 
_   underscore <Shift><-> <Shift><-> <Shift><-> 
+   addition <Shift><=> Shift><=> <Shift><=> <
<   less than <Shift><,> <Shift><,> <Shift><,> 
>   greater than .> <Shift>< .> <Shift>< .> <Shift><
?   question <Shift></> <Shift></> <Shift></> 
:    colon <Shift><;> <Shift><;> <Shift><;> 
“   quotation <Shift><’> <Shift><’> <Shift><’> 
~   tilde <Shift><`> <Shift><`> <Shift><`> 
-    hyphen <-> <-> <-> 
=   equal <=> <=> <=> 
[   left bracket <[> <[> <[> 
]   right bracket <]> <]> <]> 
\   backward slash <\> <\> <\> 
;   semicolon <;> <;> <;> 
’   apostrophe <’> <’> <’> 
,   comma <,> <,> <,> 
.   period <.> <.> <.> 
/   forward slash </> </> </> 
`   grave accent <`> <`> <`> 
Attn --- --- <attn> 
Bottom <Bottom> --- --- 
C --- <Clear> lear <Clear> 
Del --- --- > <Del
Dup --- --- <Dup> 
EEO --- <EEOF> F <EEOF> 
FM --- --- <FM> 
Fexit t> ---- ---- <Fexi
Fminus nus> ---- ---- <Fmi
Fplus us> ---- ---- <Fpl
H --- --- lp> elp <He
Home <Home> <Home> <Home> 
Insert <Insert> --- <Insert> 
PA1 <PA1> <PA1> --- 
PA2 <PA2> <PA2> --- 
PA3 <PA3> <PA3> --- 
Print --- --- nt> <Pri
Sys req --- <Sys req> <Sys req> 
Reset --- <Reset> et> <Res
Roll Down --- --- <Rol n> l Dow
Ro p --- --- < Rol  Up> ll U l

  

Top <Top> --- --- 
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mbols International Sy
Key VT100 3270 5250 

¿  <¿ <¿<¿> > > 
¡ <¡ <<¡> > ¡> 
Œ <Œ Œ<Œ> > < > 
¢ <¢> <¢> <¢> 
£ <£> <£> <£> 
¥ <¥> <¥> <¥> 
§ <§> <§> <§> 
°  <° <<°> > °> 
± <±> <±> <±> 
µ <µ> <µ> <µ> 
À <À> <À> <À> 
Á <Á> <Á> <Á> 
Â <Â> <Â> <Â> 
Ã <Ã> Ã> <Ã> <
Ä <Ä> <Ä> <Ä> 
Å <Å> <Å> <Å> 
Æ <Æ> <Æ> <Æ> 
Ç <Ç> <Ç> <Ç> 
Đ > < Đ<Đ Đ> < > 
Ñ <Ñ> <Ñ> <Ñ> 
È <È> <È> <È> 
É <É> <É> <É> 
Ê <Ê> <Ê> <Ê> 
Ë <Ë> <Ë> <Ë> 
Ì <Ì> <Ì> <Ì> 
Í <Í> <Í> <Í> 
Î <Î> <Î> <Î> 
Ï <Ï> <Ï> <Ï> 
Þ <Þ> <Þ> <Þ> 
Š <Š> <Š> <Š> 
Ò <Ò> <Ò> <Ò> 
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Ó <Ó> <Ó> <Ó> 
Ô <Ô> <Ô> <Ô> 
Õ <Õ> <Õ> <Õ> 
Ö <Ö> <Ö> <Ö> 
Ù <Ù> <Ù> <Ù> 
Ú <Ú> <Ú> <Ú> 
Û <Û> <Û> <Û> 
Ü <Ü> <Ü> <Ü> 
Ý <Ý> <Ý> <Ý> 
Ÿ <Ÿ> <Ÿ> <Ÿ> 
œ <œ> <œ> <œ> 
ß <ß> <ß> <ß> 
à <à> <à> <à> 
á <á> <á> <á> 
â <â> <â> <â> 
ã <ã> <ã> <ã> 
ä <ä> <ä> <ä> 
å <å> <å> <å> 
æ <æ> <æ> <æ> 
ç <ç> <ç> <ç> 
ð <ð> <ð> <ð> 
ñ <ñ>  <   <ñ> ñ>
è <è> <è> <è> 
é <é> <é> <é> 
ê <ê>  < <ê> ê> 
ë <ë> <ë> <ë> 
ì <ì> <ì> <ì> 
í <í> <í> <í> 
î <î> <î> <î> 
ï <ï> <ï> <ï> 
þ <þ> <þ> <þ> 
š <š> <š> <š> 
ò <ò> <ò> <ò> 
ó <ó> <ó> <ó> 
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<ô> <ô> <ô> 
<õ> <õ> <õ> 

ö <ö> <ö> <ö> 
ù ù> <ù> <ù> <
ú <ú> <ú> <ú> 
û <û> <û> <û> 
ü <ü> <ü> <ü> 
ý ý> <ý>  < <ý>
ÿ <ÿ> <ÿ> <ÿ> 
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ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into the --- 

ALPHABETIC ONLY; Trying to key a character that is not 
c. 

Ensure that you are entering input into the --- 

MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into the --- 

DECIMAL NOT VALID; Trying to key a Decimal (period). Ensure that you are entering input into the --- 

ALPHANUMERIC ONLY; Trying to key characters other than 
c. 

Ensure that you are entering input into the --- 

NUMERIC ONLY; Trying to key characters other than 
numeric. correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 

Message Reason Solution Reference Tech Note 

correct field. 

alphabeti correct field. 

correct field. 

correct field. 

Alphabetic and numeri correct field. 

Ensure that you are entering input into the 
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pressed is not valid. entering input into the 

IELD; enter data in a field that 
must be cleared first. 

entering input into the 

ED; scan into a key only field. entering input into the 

ED; key into a scan only field. entering input into the 

RT; exit the field before it is entering input into the 

LE ERROR; red an error from which 
you can continue. 

iguration settings for the 
hardware being used, usually a printer and 
cable issue. 

Encountered an error from which 
you can NOT continue. 

that your Network settings are correct 
and you are in the correct mode using the 
correct Port. 

T1171, T1187 and 
T1194 

FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which 
you can NOT continue. 

Notify Connect over the web incident 
reporting system. 

--- 

Press any key\nFor More Details...; Press Enter for more information. Advisory message. --- 

Press any key; Press a key to continue. Advisory message. --- 

INVALID KEY; The key Ensure that you are 
correct field. 

--- 

MUST CLEAR F Trying to Ensure that you are 
correct field. 

--- 

SCAN NOT ALLOW Trying to Ensure that you are 
correct field. 

--- 

KEY NOT ALLOW Trying to Ensure that you are 
correct field. 

--- 

ENTRY TOO SHO Trying to 
filled. 

Ensure that you are 
correct field. 

--- 

RECOVERAB Encounte Verify that your conf --- 

UNRECOVERABLE ERROR; Verify

 

T1113, T1114, T1161, 
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R.\nREBOOT t Connect. ork settings are correct 
and you are in the correct mode using the 
correct Port. 
 

T1171, T1187 and 
T1194 

R.\nREBOOT 
MOBILE UNIT; 

t Disconnect. ork settings are correct 
and you are in the correct mode using the 
correct Port. 

T1171, T1187 and 
T1194 

RF Send ERROR.\nREBOOT MOBILE 
UNIT; 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 

ment. 
T1171, T1187 and 
T1194 

RF Receive ERROR.\nREBOOT 
 UNIT; 

Could not Receive. Most likely a range, access point, radio, 
e. Troubleshoot the 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

EBOOT t run the RF Survey. access point, radio, 

customer’s environment. 
T1171, T1187 and 
T1194 

MOBILE UNIT; 
Have been trying to contact the 
host for the radio timeout period (2 

default). 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 

ment. 
T1171, T1187 and 
T1194 

REBOOT MOBILE UNIT; Reboot the Mobile Unit do to loss 
ction. 

Most likely a range, access point, radio, 
e. Troubleshoot the 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

; . e again, or perhaps 

Mobile Unit and is on. 
 

Connection ERRO
MOBILE UNIT; 

Could no Verify that your Netw T1113, T1114, T1161, 

Disconnect ERRO Could no Verify that your Netw

 

T1113, T1114, T1161, 

Could not Send. 

customer’s environ

T1113, T1114, T1161, 

MOBILE host or network issu
customer’s environment. 

RF Check ERROR.\nR
MOBILE UNIT; 

Could no Most likely a range, 
host or network issue. Troubleshoot the 

T1113, T1114, T1161, 

RF Timeout ERROR.\nREBOOT 

minutes customer’s environ

T1113, T1114, T1161, 

of conne host or network issu
customer’s environment. 

Retry (Y/N)? Try again Try to send or receiv
ensure that the printer is cabled to the 

--- 
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Sending Data; nit out of the coverage access point, radio, 

customer’s environment. 
T1171, T1187 and 
T1194 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 

ment. 
T1171, T1187 and 
T1194 

Host Received Data\nAwaiting App Mobile Unit has sent and received 
wledgement from the IP 

stack and is waiting for the 
application to return data. 

Most likely a host or network issue. 
stomer’s environment. 

locking, application program failure, Host 
failure or network failure. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit out of the coverage 
area. host or network issue. Troubleshoot the 

customer’s environment. 
T1171, T1187 and 
T1194 

TCP Error Reading\nMAC 
Address.\nREBOOT MOBILE UNIT; 

Could not obtain the Mac Address 
from the Mobile Unit. 

Possible hardware, driver or stack problem 
Contact the Mobile Unit manufacturer. 

--- 

Invalid TIP Command; Bad internal protocol. Notify Connect over the web incident --- 

Session Ended\nBy User or Host; User, Host, application or network 
has ended the session. 

If the user did not end the session, most 
likely host or network issues. Troubleshoot 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

r; ocol detected. ad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
Server operation. 

TIMEOUT\n\n Mobile U
area. 

Most likely a range, 
host or network issue. Troubleshoot the 

T1113, T1114, T1161, 

TIMEOUT\n\nReceiving Data; 

customer’s environ

T1113, T1114, T1161, 

Reply!; an ackno Troubleshoot the cu
Probable causes are Database record 

* WAITING TO SEND  *; Most likely a range, access point, radio, T1113, T1114, T1161, 

reporting system. 

the customer’s environment. 

Server Packet Erro Bad Prot Usually a result of b --- 
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g host\nlist from Server; ocol detected. ad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
Server operation. 

Unexpected Server\ndata received; ad Protocol detected. sult of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 

Error starting\nhost application; Connected to the server but can 
not connect to the distant end. 

Configure the server handler to access the 
host application. 

--- 

Select Host or App; Need to choose your 
Host/application destination. 

User selection required. --- 

Connecting...; Attempting to connect to the 
Host/application. 

Advisory message. --- 

TCP Error\nReading IP 
Address\nREBOOT MOBILE UNIT; 

Mobile Unit missing Network IP 
information. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Printer start error; Could not initialize the printer. 
 

Cable or power issue with the printer. --- 

Not enough power to print. Replace the battery with a fully recharged 
battery. 
 

Paper Feed Error\nFix Then Hit Enter; Paper in the printer is not ready. Replace the paper or rethread the paper in 
the printer. 
 

r Error\nPrint Ended; print. , communication 

Error receivin Bad Prot Usually a result of b --- 

B Usually a re

Server operation. 

--- 

 
Battery too low\nto print; --- 

--- 

Printe Can not Check cable, battery
settings and paper in the printer. 

--- 
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User Count Exceeded.\n Session Possible authorization issue. Verify that you have the correct number of 

ber of Mobile Units you 

 

--- 

Primary Unavailable\nTrying Alternate; First Host IP address not available 
 remaining addresses in 

the Host list. 

Verify the host address. --- 

APMAC.DAT Error\nSession Ended; Access point Media Access Control Most likely a range, access point, radio, 
e. Troubleshoot the 

customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Session Ended;  nit IP Error. Unit network setting 
issue. Troubleshoot the customer’s 
environment. 

T1171, T1187 and 
T1194 

Missing Subnet IP\nSession Ended;  Mobile Unit IP Netmask Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s T1171, T1187 and 

T1194 

Error Opening File;  File is missing. Verify that the configuration files are on the 
Mobile Unit.  Or perhaps there is a 

--- 

Telnet API\nnot found; Program files are missing. Reload program files. --- 

Battery Low Warning\n\nReplace 
Battery Soon;  

Not enough power to operate the 
Mobile Unit. 

Replace the battery with a fully recharged 
battery. 

--- 

No Host List.\nPress any key\nTo Edit 
Host IP's;  

Have not configured your target 
hosts. 

Configure the target host IP addresses. --- 

Unable to Allocate\nFont Memory; Mobile Unit does not have enough 
memory to load the fonts. 

Reduce the fonts in use or expand the 
memory in the Mobile Unit. 
 

--- 

Ended;  licenses for the num
are using. 

trying the

error. host or network issu

MUIP.DAT Error\n Mobile U Most likely a Mobile 

 

T1113, T1114, T1161, 

environment. 
 

T1113, T1114, T1161, 

hardware failure. 
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rror; t load the font. 

 

 is available to load. 

Printer Not Ready\nPress R to 
Cancel Print; 

Can not print. Check cable, battery, communication 
n the printer. 

--- 

Mobile Unit in\nDemonstration 
ient;  

Running in demo mode. Purchase a license from Connect. --- 

Connected to Host;  Successful connection to the target Advisory message. --- 

Telnet Mode not\nsupported on\nthis 
t;  

This Mobile Unit must be used with 
t Server. 

Order a Connect Server. --- 

Telnet Setup files\nnot found. 
Reload\nfiles then switch;  

Customer specific configuration 
files are missing. 

Load the configuration files into the Mobile 
Unit from Twin Client Manager. 

--- 

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode 
direct to the target Host. 

Advisory message. --- 

Switched Client to\nServer Based 
Mode;  

Mobile Unit running through a 
Connect server in thin mode 

t port 1800. 

Advisory message. --- 

Port 23 is only\nallowed in Telnet 
Mode;  

Can not set the port to 23 in Server 
mode.  Port 23 is the standard 

rt. 

Advisory message. --- 

Not Enough Memory\nTo Run; Mobile Unit does not have the 
capacity to run the program do to 

restrictions. 

Expand the Mobile Unit memory. --- 

Press any key; Press a key to continue. Advisory message. --- 

Font Loading E Could no
 

Ensure that the font --- 

Retry\nC to settings and paper i

Mode\nfor TwinCl

Host. 

Mobile Uni a Connec

 

usually a

Telnet po

memory 
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lnet;  

rver;  

lient TN3270; 

Client TN5250; 

nt TNVT; 

Connect; 

ions; e. 

tion. 

ost IPs; tion. 

Option; tion. 

TwinClient Te Prompt. Advisory message. --- 

TwinClient Se Prompt. Advisory message. --- 

TwinC Prompt. Advisory message. --- 

Twin Prompt. Advisory message. --- 

TwinClie Prompt. Advisory message. --- 

(c) 1991-2006 Prompt. Advisory message. --- 

Edit Menu Opt Menu Titl Advisory message. --- 

Edit Mobile Unit IP; Menu Op Advisory message. --- 

Edit Server/H Menu Op Advisory message. --- 

Edit Radio Menu Op Advisory message. --- 
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y;  tion. 

 Survey;  tion. 

nt Modes; tion. 

winClient; tion. 

tion. 

t be\nplugged in print. , communication 

 OF BASE; nit out of the coverage access point, radio, 

customer’s environment. 
T1171, T1187 and 
T1194 

CONNECT SERIAL CABLE; Serial cable not connected to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

REMOVE SERIAL CABLE; Remove serial cable from to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

PLACE IN CRADLE; Place the Mobile Unit in the cradle.

Edit License Ke Menu Op Advisory message. --- 

Run Site Menu Op Advisory message. --- 

Switch Clie Menu Op Advisory message. --- 

Run T Menu Op Advisory message. --- 

Exit to OS;  Menu Op Advisory message. --- 

Printer may no
or\nturned on!; 

Can not Check cable, battery
settings and paper in the printer. 

--- 

OUT OF RANGE Mobile U
area. 

Most likely a range, 
host or network issue. Troubleshoot the 

T1113, T1114, T1161, 

--- 

--- 

Advisory message. --- 
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REMOVE FROM CRADLE; Remove Mobile Unit from the Advisory message. 

ACQUIRING CRADLE BUS;  Attempting to access the cradle 
he serial port you have 

Advisory message. --- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or radio 
 the customer’s 

 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Refused\nBy Host; You connected to the target host 
ost disconnected you. 

Verify that the configuration file has the 
ype and New 

environment variable set.  Fallback to the 
Connect Default to verify the connection. 

--- 

Timed Out; ected to the host but did 
not logon in the appropriate time so 
the host disconnected you. 

meters for login. 

Failed\nHost Not 
Responding; 

t connect to the Host. access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1171, T1187 and 
T1194 

Connection Failed\nHost Unreachable; Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 

ent. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
it; 

Mobile Unit out of the coverage Most likely a range, access point, radio, 
e. Troubleshoot the 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

f Range, 
Unable\nTo Receive; 

nit out of the coverage 
area. 

access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

cradle. 
--- 

through t
configured. 

issue. Troubleshoot
environment. 

but the h correct Mobile Unit t

Connection You conn Modify the Host para --- 

Connection Could no Most likely a range, T1113, T1114, T1161, 

customer’s environm

Unable\nTo Transm area. host or network issu
customer’s environment. 

Mobile Unit Out\nO Mobile U Most likely a range, --- 
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onding; print. , communication 

 
 

ange; ut of the coverage area. access point or radio 
issue. Troubleshoot the customer’s 
environment. 

T1171, T1187 and 
T1194 

Yes or No prompt for a reprint. 

Turning power off\nduring a 
session\nwill cause the\nprogram to 

This Mobile Unit will disconnect the 
session if powered off. Advisory message. 

Yes or No prompt for a 
confirmation. 

You Sure? (YyNn); Yes or No prompt for a 
confirmation. 

Advisory message. --- 

Domain Name Server\nNot Set; DOMAIN NAME SERVER not 
configured. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Domain Name Server\nQuery Memory 
Error; 

Memory error on the Mobile Unit Expand the Mobile Unit memory or return 
the Mobile Unit for repair. 

--- 

Printer Not\nResp Can not Check cable, battery
settings and paper in the printer. 

--- 

Printer Out\nOf R Printer o Most likely a range, 

 
Advisory message. 

T1113, T1114, T1161, 

Print Complete; Prompt. --- 

Reprint (Y/N)?; Advisory message. --- 

WARNING;  Prompt. Advisory message. --- 

restart; 
Are you sure (y/n)?; 

Mobile Unit manufacturer limitation. --- 

Advisory message. --- 
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er\nQuery Sending nit out of the coverage access point, radio, 

customer’s environment. 
T1171, T1187 and 
T1194 

Domain Name Server\nQuery Receive 
Error;  

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 

ment. 
T1171, T1187 and 
T1194 

Domain Name Server\nUnavailable; Could not connect to the DOMAIN 
ERVER. 

Most likely a range, access point, radio, 
e. Troubleshoot the 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

ter file; t load the parameter file. onfiguration files. 

open\ntelnet interface; t Telnet.  files. --- 

ot set\mtelnet options; t use the Telnet onfiguration files. 

Setup file\nsetting mismatch\nReload 
Setup; 

Emulation program selected is not 
compatible with the configuration 
file on the Mobile Unit. 

Remove the emulation and configuration 
files. Run clear Telnet on the Mobile Unit 
then reload the Mobile Unit with the proper 
emulation and configuration files. 

--- 

Display formatting\ntoo large 
for\ncurrent screen; 

Mobile Unit does not have enough 
memory to run your configured 
reformatted screens. 

Expand the Mobile Unit memory or order a 
server from Connect. 

--- 

Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the manufacturer --- 

Domain Name Serv
Error; 

Mobile U
area. 

Most likely a range, 
host or network issue. Troubleshoot the 

T1113, T1114, T1161, 

T1113, T1114, T1161, 

customer’s environ

NAME S host or network issu
customer’s environment. 

Error loading\nparame Could no Reload the correct c --- 

Could not Could no Reload the program

Could n Could no
configuration. 

Reload the correct c --- 

for repair. 
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Host/App/Network\nclosed the session; Customer’s environment 
disconnected the Mobile Unit 
session. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnecting...;   Prompt. Advisory message. --- 

Scan Barcode; Bar code scanning test. Advisory message. --- 

Enter Setup\nPassword;  Prompt. Advisory message. --- 

Enter Profile \nPassword; Prompt. Advisory message. --- 

Host IP; Host IP address prompt. Enter target host IP address. --- 

Host Name; Host name prompt. Enter target host Name. --- 

Port; Host IP port required. Enter 23 for Telnet or 1800 for a Connect 
Server. Could also be a different number 
depending on the customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Type;  Prompt. Advisory message. --- 

WARNING: This will \nend any\ncurrent 
session; 

Prompt. Advisory message. --- 
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Continue (Y/N)?; Prompt. Advisory message. --- 

HOST ENTRY; Prompt. Advisory message. --- 

VT(100/220) Setup; Prompt. Advisory message. --- 

Mobile Unit Info; Prompt. Advisory message. --- 

Emulation Setup; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Miscellaneous Setup; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 



  Error Message Resolution Guide 

PowerNet Twin Client Reference  •   May, 2006    11-15

 

Message Reason Solution Reference Tech Note 
    

<BK SP> Sends; Prompt. Advisory message. --- 

New Line Mode; Prompt. Advisory message. --- 

Insert Mode; Prompt. Advisory message. --- 

Autowrap Mode; Prompt. Advisory message. --- 

Cursor; Prompt. Advisory message. --- 

EMULATION SETUP; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

Map Underline; Prompt. Advisory message. --- 

Break Key; Prompt. Advisory message. --- 
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ANSI Setup; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Backspace Key; Prompt. Advisory message. --- 

MISCELLANEOUS SETUP; Prompt. Advisory message. --- 

Test Options; Prompt. Advisory message. --- 

Login Options; Prompt. Advisory message. --- 

TEST OPTIONS; Prompt. Advisory message. --- 

Printer Test; Prompt. Advisory message. --- 

Scan Code Test; Prompt. Advisory message. --- 

LOGIN OPTIONS; Prompt. Advisory message. --- 
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User Name; Prompt. Advisory message. --- 

User Password;  Prompt. Advisory message. --- 

ON; Prompt. Advisory message. --- 

OFF; Prompt. Advisory message. --- 

Map; Prompt. Advisory message. --- 

Don't Map; Prompt. Advisory message. --- 

Enable Break; Prompt. Advisory message. --- 

Disable Break; Prompt. Advisory message. --- 

7 bit; Prompt. Advisory message. --- 

8 bit; Prompt. Advisory message. --- 
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Send Delete; Prompt. Advisory message. --- 

Send Backspace;  Prompt. Advisory message. --- 

Mobile Unit Setup; Prompt. Advisory message. --- 

Scanner Options; Prompt. Advisory message. --- 

Program Options; Prompt. Advisory message. --- 

Special Options;  Prompt. Advisory message. --- 

Beeper Options;  Prompt. Advisory message. --- 

Exit to DOS; Prompt. Advisory message. --- 

Backlight Time; Prompt. Advisory message. --- 

Enter Key Action; Prompt. Advisory message. --- 
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Reset Options; Prompt. Advisory message. --- 

Font Size;  Prompt. Advisory message. --- 

Portable Printer; Prompt. Advisory message. --- 

Reprint Option; Prompt. Advisory message. --- 

Data IDs; Prompt. Advisory message. --- 

Internal/External; Prompt. Advisory message. --- 

Modify Beeps; Prompt. Advisory message. --- 

Message Beeps;  Prompt. Advisory message. --- 

Scan Identifier; Prompt. Advisory message. --- 

AID Scan Setup; Prompt. Advisory message. --- 
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Long Scans; Prompt. Advisory message. --- 

Scan Send;  Prompt. Advisory message. --- 

Yes; Prompt. Advisory message. --- 

No;  Prompt. Advisory message. --- 

Normal; Prompt. Advisory message. --- 

Double Wide; Prompt. Advisory message. --- 

Double High; Prompt. Advisory message. --- 

Double High and Wide; Prompt. Advisory message. --- 

Errors Only; Prompt. Advisory message. --- 

Automatic; Prompt. Advisory message. --- 
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All Messages;  Prompt. Advisory message. --- 

Reject; Prompt. Advisory message. --- 

Truncate; Prompt. Advisory message. --- 

Split;  Prompt. Advisory message. --- 

Do Not Send; Prompt. Advisory message. --- 

Always Send; Prompt. Advisory message. --- 

Last Field Only; Prompt. Advisory message. --- 

Internal; Prompt. Advisory message. --- 

External; Prompt. Advisory message. --- 

none; Prompt. Advisory message. --- 



Error Message Resolution Guide 

  PowerNet Twin Client Reference    •   May, 2006 11-22

 

Message Reason Solution Reference Tech Note 
    

monarch; Prompt. Advisory message. --- 

pddumb; Prompt. Advisory message. --- 

comtec; Prompt. Advisory message. --- 

rascal; Prompt. Advisory message. --- 

codewriter; Prompt. Advisory message. --- 

comtec(S); Prompt. Advisory message. --- 

User Name; Prompt. Advisory message. --- 

Password;  Prompt. Advisory message. --- 

Frequency:      Hz; Prompt. Advisory message. --- 

Duration:       ms; Prompt. Advisory message. --- 
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Delay:          ms;  Prompt. Advisory message. --- 

Select Scanner; Prompt. Advisory message. --- 

Setup Scanner; Prompt. Advisory message. --- 

Scan Test; Prompt. Advisory message. --- 

Scan Operation;  Prompt. Advisory message. --- 

Laser; Prompt. Advisory message. --- 

Contact/Pulse; Prompt. Advisory message. --- 

Contact/No Pulse; Prompt. Advisory message. --- 

Auto/Pulse; Prompt. Advisory message. --- 

Auto/No Pulse; Prompt. Advisory message. --- 
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Wand Simulation;  Prompt. Advisory message. --- 

VT100; Prompt. Advisory message. --- 

VT220; Prompt. Advisory message. --- 

SETUP; Prompt. Advisory message. --- 

Mobile Unit IP/Radio; Prompt. Advisory message. --- 

Host List; Prompt. Advisory message. --- 

NULL; Prompt. Advisory message. --- 

 

 

 

 

 


